Administrator Guide

Special notice
Before using this information and the product it supports, read the information in Notices on page 113.

Chapter 1. Administrator Guide
This guide describes how to install Rational® Performance Tester software. After you install the software,
you can perform administration tasks such as license configuration and integration with other products.
This guide is intended for administrators.

Installing
Installing the product involves verifying requirements, planning, managing licenses, and configuring webbased help. This section lists all such topics.

Installing Rational® Performance Tester and Rational® Performance Tester
Agent
Installing the product involves verifying requirements, planning, managing licenses, and configuring webbased help.
Note: Before installing, consult the IBM® Rational® Performance Tester Release Notes on page
for any late-breaking installation issues.
This installation guide covers two independent products: Rational® Performance Tester and the
Rational® Performance Tester Agent. The Rational® Performance Tester Agent is a tool that you use with
Rational® Performance Tester. It is included as part of the Rational® Performance Tester product kit.
Rational® Performance Tester Agent consists of two capabilities:
• Generate load for the application under test by using the virtual users. You can increase the load
generation capacity by installing additional agents on remote computers.
• Gather data for the Response Time Breakdown feature and in support of the startup and control of
web services stubs in the SOA protocol.
Note: The Rational® Performance Tester workbench and Agent products are separate offerings and
must be installed separately.
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Installation requirements
Installation requires the correct hardware, software, server environment, operating systems, and user
privileges for installing and running your software.

Hardware and Software requirements
Before you install the product, verify that your system meets the hardware and software requirements.
For information about hardware and software compatibility, see System Requirements on page

.

User privileges requirements
You must have a user ID that meets the following requirements to install Rational® Performance Tester,
Rational® Service Tester, and Rational® Performance Tester Agent.
• Your user ID must not contain double-byte characters.
•

You must have a user ID that belongs to the Administrators group.

•

You must be able to log in as root.

Capacity Planning
This document offers a methodology for assessing the CPU and memory characteristics of a given test
and provides a set of best practices for scaling up to high volume loads using Rational® Performance
Tester.
For information about capacity planning, see Capacity planning for Rational® Performance Tester.

Installation of Rational® Performance Tester or Rational® Performance
Tester Agent on Windows™ or Linux™ or Mac
The Setup disk includes the launchpad program, which provides you with a single location to start the
installation process.Download the product bits and from the IBM® Installation Manager point to the Setup
disk.
Use the launchpad program to start the installation of software in these cases:
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• Installing from product CDs
• Installing from an electronic image on your local file system
• Installing from an electronic image on a shared drive
Note: For Linux™ computers, you must log in as the root user before you begin installation process.
For products that are installed by IBM® Installation Manager, starting the installation process from the
launchpad program causes Installation Manager to be automatically installed if it is not already on your
computer. Furthermore, the installation process is already configured with the location of the repository
that contains the installation package. If you install Installation Manager separately, you must configure
the repository preferences manually. Also, you can start the installation of a number of supporting
software items from the launchpad.
To install Rational® Performance Tester as a non-administrator, you cannot use the launchpad program
to start the installation process. Instead, you must manually run the userinst program from the Setup
disk. Running the userinst program provides the same functions as starting the installation of Rational®
Performance Tester from the launchpad.

Installation overview
Follow these broad steps to install the product. The linked topics provide procedures and details for each
step.
To install the product complete these procedures:
1. Review the release notes on page

.

2. Plan the installation.
a. Review hardware and software requirements on page 4.
b. Review user privilege requirements on page 4.
c. Plan for installation locations on page 8.
d. Plan for product coexistence on page 8.
e. Install with your instance of Eclipse on page 9.
f. Plan for current and later capacity requirements on page 4.
3. Install the product on page 4.
4. Install the Rational® Performance Tester Agent on page 15.
5. Set up and manage product licenses on page 22.
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Installation conventions and terminology
Understanding these terms and conventions can help you take full advantage of the installation
information and your product.
The following conventions are used in this installation information:
• The default installation directory is written as C:\installation_directory\product\inst.file.
• The default log location for installation information is C:\log_file_dir\log.txt.
These terms are used in the installation topics.
Installation directory
The location of product artifacts after the package is installed.
Package
An installable unit of a software product. Software product packages are separately
installable units that can operate independently from other packages of that software
product.
Package group
A package group is a directory in which different product packages share resources with
other packages in the same group. When you install a package using Installation Manager,
you can create a new package group or install the packages into an existing package group.
Eclipse-based packages installed in the same package group are able to use the shellsharing features of Eclipse. Some packages cannot share a package group, in which case
the option to use an existing package group is unavailable.
Repository
A storage area for installable software packages. A repository can be disc media, a folder on
a local hard disk, or a server or web location.
Shared directory
In some instances, product packages can share resources. These resources are located in a
directory that the packages share.

Planning the installation
Read all the topics in this section before you begin to install or update any of the features of your product.
Effective planning and an understanding of the key aspects of the installation process can help ensure a
successful installation.
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Installation Manager overview
IBM® Installation Manager is a program for installing, updating, and modifying packages. It helps you to
manage the applications or packages that it installs on your computer. Installation Manager also helps
you to keep track of what you have installed, determine what is available for you to install, and to organize
installation directories.
Installation Manager provides features that help you keep packages up to date, modify packages, manage
the licenses for your packages, and uninstall packages.
Installation Manager includes six wizards that make it easy to maintain packages:
• The Install wizard walks you through the installation process. You can install a package by simply
accepting the defaults or you can modify the default settings to create a custom installation.
Before you install, you get a complete summary of your selections throughout the wizard. Using the
wizard you can install one or more packages at one time.
• The Update wizard searches for available updates to packages that you have installed. An update
might be a released fix, a new feature, or a new version of the product. Details of the contents of
the update are provided in the wizard. You can choose whether to apply an update. The Update
wizard searches connected repositories for updates. If you are not connected to the Internet,
you may not see newly available updates for your installed products. To apply an update to a
computer that is not connected to the Internet, you must download the update and extract it to a
local repository.
• The Modify wizard helps you modify certain elements of a package that you have already installed.
During the first installation of the package, you select the features that you want to install. Later, if
you require other features, you can use the modify packages wizard to add them to your package.
You can also remove features and add or remove languages.
• The Manage Licenses wizard helps you set up the licenses for your packages. Use this wizard to
change your trial license to a full license, to set up your servers for floating licenses, and to select
which type of license to use for each package. Rational® Performance Tester requires runtime
floating license keys to run tests with multiple virtual users and to use product extensions such as
protocols. Runtime floating license keys are not managed using IBM® Installation Manager.
• The Roll Back wizard helps you to revert to a previous version of a package.
• The Uninstall wizard removes a package from your computer. You can uninstall more than one
package at a time.
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Installation considerations
Part of planning entails making decisions about installation locations, working with other applications,
extending Eclipse, upgrading, migrating, and configuring help content.

Installation locations
IBM® Installation Manager retrieves product packages from specified repositories and installs the
products into selected locations, which are referred to as package groups.

Package groups
During installation, you specify a package group into which to install a product.
• A package group represents a directory in which products share resources.
• When you install a product by using Installation Manager, you either create a package group or
install the product into an existing package group. A new package group is assigned a name
automatically; however, you choose the installation directory for the package group.
• After you create a package group you cannot change the installation directory. The installation
directory contains files and resources that are shared by the products that are installed into that
package group.
• Product resources that are designed to be shared with other packages are installed in the shared
resources directory. Not all products can share a package group, in which case the option to use an
existing package group is disabled.
• When you install multiple products at the same time, all products are installed into the same
package group.

Shared resources directory
The shared resources directory is where product resources are installed so that they can be used by
multiple product package groups. You define the shared resources directory the first time that you install
the first product package. For best results, use your largest disk drive for shared resources directories.
You cannot change the directory location unless you uninstall all product packages.

Coexistence
Some products are designed to coexist and share functions when they are installed in the same package
group. A package group is a location where you can install one or more software product packages.
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Offering coexistence considerations
When you install each product package, you select whether to install the product package into an
existing package group or to create a package group. IBM® Installation Manager prevents you from
installing products into package groups products that are not designed to share or do not meet version
compatibility and other requirements. To install more than one product at a time, the products must be
able to share a package group.
Any number of eligible products can be installed to a package group. When a product is installed, the
product functions are shared with all the other products in the package group. If you install a development
product and a testing product into one package group, when you start either of the products, you have
both the development and testing functions available to you in your user interface. If you add a product
with modeling tools, all the products in the package group have the development, testing, and modeling
functions available.

Installing with your Eclipse instance
The product package that you install using IBM® Installation Manager comes with a version of Eclipse,
which is the base platform of this product package. If you already have Eclipse installed on your
workstation, you can add your product package directly to that Eclipse installation and extend the
functions of the Eclipse integrated development environment (IDE).
Extending an Eclipse IDE adds the functions of the newly installed product, but maintains your IDE
preferences and settings. Previously installed plug-ins are also still available.
In most cases, your current Eclipse IDE must be the same version as the Eclipse that the product you
are installing uses. Installation Manager checks that the Eclipse instance that you specify meets the
requirements for the installation package and helps you install the latest updates from eclipse.org, if
required.

Increasing the number of file handles on Linux™ workstations
For best product performance, increase the number of file handles above the default setting of 1024
handles.
Important: Before you work with your product, increase the number of file handles. Most products
use more than the default limit of 1024 file handles per process. A system administrator might need to
make this change.
Exercise caution when using the following steps to increase your file descriptors on Linux™. If the
instructions are not followed correctly, the computer might not start correctly.
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To increase your file descriptors:
1. Log in as root. If you do not have root access, you must obtain it before continuing.
2. Change to the etc directory.
Attention: If you decide to increase the number of file handles in the next step, do not leave
an empty initscript file on your computer. If you do so, your computer will not start up the next
time that you turn it on or restart.
3. Use the vi editor to edit the initscript file in the etc directory. If this file does not exist, type vi
initscript

to create it.

4. On the first line, type ulimit

-n 30000.

The point is that 30000 is significantly larger than 1024, the

default value on most Linux™ computers.
Important: Do not set the number of handles too high, because doing so can negatively impact
system-wide performance.
5. On the second line, type eval

exec "$4".

6. Save and close the file after making sure that you have completed steps 4 and 5.
Note: Ensure that you follow the steps correctly. If this procedure is not completed correctly,
your computer will not start.
7. Optional: Restrict the number of handles available to users or groups by modifying the
limits.conf file in the etc/security directory. Both SUSE Linux™ Enterprise Server (SLES)
Version 9 and Red Hat Enterprise Linux™ Version 4.0 have this file by default. If you do not have this
file, consider using a smaller number in step 4 in the previous procedure (for example, 2048). Do
this so that most users have a reasonably low limit on the number of open files that are allowed
per process. If you use a relatively low number in step 4, it is less important to do this. However,
if you set a high number in step 4 earlier and you do not establish limits in the limits.conf file,
computer performance can be significantly reduced.
The following sample limits.conf file restricts all users, and then sets different limits for others
afterwards. This sample assumes that you set handles to 8192 in step 4 earlier.
*

soft nofile 1024

*

hard nofile 2048

root

soft nofile 4096

root

hard nofile 8192

user1

soft nofile 2048

user1 hard nofile 2048
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Note that the * in the preceding example sets the limits for all users first. These limits are lower
than the limits that follow. The root user has a higher number of allowable handles open, while the
number that is available to user1 is between the two. Make sure that you read and understand the
documentation that the limits.conf file contains before making changes.
For more information on the ulimit command, see the main page for ulimit in the Linux™ documentation.

Starting the launchpad
To install the product, start the launchpad program.
Depending on the source of the product installation, follow one of these procedures to start the launchpad
program;
• If you are installing from the CDs, complete these steps:
a. Insert the Setup CD into your CD drive.
b.

Mount the CD drive.

c. If autorun is enabled on your computer, the launchpad program starts automatically. If the
launchpad does not start automatically, complete one of these steps:
Run the launchpad.exe command, which is located in the root directory of

◦
the CD.
◦

Run the launchpad.sh, which is located in the root directory of the CD.

• If you are installing from electronic disks that you downloaded from IBM® Passport Advantage®,
open a command line, and change to the directory where you extracted the disk images; and then
at the command prompt, complete one of these steps:
◦

Enter RPT_SETUP\launchpad.exe.

◦

Enter RPT_SETUP/launchpad.sh.

The launchpad program starts.

Installing Rational® Performance Tester
To test the performance of an application, you must install Rational® Performance Tester.
You must read the tech-note if you are using Mozilla Firefox version 43 or later before you can install the
product on Linux or Mac platform. For more information about tech-note, refer to The launchpad does not
open when opening launchpad from the terminal.
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If you use the Launchpad program to install the product, IBM Installation Manager is installed
automatically if you do not have it on your computer. After the installation is complete, IBM® Installation
Manager starts the product installation by using the preconfigured repository that contains the product
package.
If you install Installation Manager and then install the product, you must set the repository preferences
manually.
1. Review the Installation considerations on page 8, if you have not done so already.
2. Complete one of the following steps:
a. If you are installing from compressed files, such as .zip or ISO files, extract
the files into a common directory. Navigate to Common_Directory/RPT/
disk1/Platform_Directory and double click install.exe.
b. If you are installing from a CD, insert the first product disc into your CD drive. If autorun is
enabled on your workstation, then the launchpad starts automatically. Otherwise, start the
launchpad program manually.
•

Run the launchpad.exe command, which is located in the root directory of
the Setup disk installation image.

•

Run the launchpad.sh command, which is located in the root directory of the
Setup disk installation image.

•

From the command line terminal, run open Launchpad.app from the
root directory of the Setup disk installation image.

Note: Mac OS commands are case-sensitive.
3. Select a language in which to run the launchpad and Installation Manager.
4. Select the product to install from the launchpad menu.
The Install Packages window opens.
5. Click a product package to highlight it.
The description of the package is displayed in the Details pane at the end of the screen.
6. To search for updates to the product packages, click Check for Other Versions, Fixes,
and Extensions. If updates for a product package are found, then they are displayed in the
Installation Packages list on the Install Packages page under their corresponding products. Only
recommended updates are displayed by default.
• To view all updates that are found for the available packages, click Show all versions.
• To display a package description in the Details pane, click the package name. If additional
information about the package is available, such as a readme file or release notes, a More
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info link is included at the end of the description text. Click the link to display the additional
information in a browser. To fully understand the package that you are installing, review all
information.
7. Select the product package and any updates to the package to install. Updates that have
dependencies are automatically selected and cleared together. Click Next to continue.
Note: If you install multiple packages at the same time, then all the packages are installed into
the same package group.
8. On the Prerequisite page, if a supported version of IBM® Rational® License Key Administrator
is not installed, a warning message is displayed. A supported version of Rational® License Key
Administrator comes with the product. To administer a license server, you must install a supported
version of Rational® License Key Administrator. If you use the launchpad program to install the
product, Rational® License Key Administrator is listed on the Install Packages page. If you start
Installation Manager, you must add the repository for Rational® License Key Administrator to
install it at the same time as the product. Click Next to continue.
9. On the Licenses page, read the license agreement for the selected package.
a. If you agree to the terms of all of the license agreements, click I accept the terms of the
license agreements.
b. Click Next to continue.
10. On the Location page, type the path for the shared resources directory in the Shared Resources
Directory field, or accept the default path. The shared resources directory contains resources that
can be shared by one or more package groups. Click Next to continue.
The default path to use follows:
•

C:\Program Files\IBM\IBMIMShared

•

/opt/IBM/IBMIMShared

•

/Applications/IBM/IBMIMShared

Important: You can specify the shared resources directory only the first time that you install a
package. Use your largest disk for this to help ensure adequate space for the shared resources of
future packages. You cannot change the directory location unless you uninstall all packages.
11. On the Location page, create a package group to install the product package into or if this is an
update, use the existing package group. A package group represents a directory in which packages
share resources with other packages in the same group. To create a package group:
a. Click Create a new package group.
b. Type the path for the installation directory for the package group.
The name for the package group is created automatically.
The default path follows:
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•

C:\Program Files\IBM\SDP

•

/opt/IBM/SDP

•

/Applications/IBM/SDP

c. Click Next to continue.
12. Optional: On the next Location page, you can choose to extend an existing Eclipse IDE that is
installed on your computer, which adds the functions in the packages that you are installing. You
must have Eclipse Version 3.6 with the latest updates from eclipse.org to select this option. Click
Next to continue.
Note: Rational® Performance Tester does not support extending an existing Eclipse IDE.
13. On the Features page under Translations, select the languages for the package group. The
corresponding translations for the user interface and documentation for the product package will
be installed.
14. On the next Features page, select the package features to install.
a. Optional: To see the dependency relationships between features, select Show
Dependencies.
b. Optional: Click a feature to view its brief description under Details .
c. Select or clear features in the packages. Installation Manager automatically enforces any
dependencies with other features and displays updated download sizes and disk space
requirements for the installation.
d. To use Processor Value Unit (PVU) licensing capability, click IBM Rational Test Workbench
Processor Value Unit (PVU) support check box.
Rational® Performance Tester supports the Processor Value Unit (PVU) licensing capability
available with the following newly introduced offerings:
• IBM Rational Performance Test Server
• IBM Rational Test Virtualization Server
• IBM Rational Test Workbench
All of these offerings include either Rational® Performance Tester or the Rational®
Performance Tester Agent. When you use any of these new offerings, Rational®
Performance Tester utilizes PVU licensed agents to generate virtual user load without the
need for Virtual Tester Pack licenses. This virtual user load is limited only by the capacity of
the PVU licensed agents.
e. When you integrate Rational® Performance Tester along with Rational® Application
Developer or Rational® Software Architect in a shell-shared mode, you must clear Java 8
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OpenJDK with Eclipse OpenJ9 check box during the installation. If you not clear this check
box, multiple instances of OpenJDK are installed as Rational® Application Developer and
Rational® Software Architect already have an existing OpenJDK.
Note: If you install Rational® Application Developer or Rational® Software Architect in a
separate package, you can select the Java 8 OpenJDK with Eclipse OpenJ9 check box.
f. When you are finished selecting features, click Next to continue.
15. On the common licensing configuration page, type the TCP/IP port number and host name of the
license servers to use to configure licensing on the workbench computer. Separate the port number
and host name with the at sign (@). Separate the port-host pairs with semicolons (;). To use the
default port, omit the port number. If you do not know the port numbers and names of license
servers to use, you can configure the license servers after installation by using Rational® License
Key Administrator.
For example, to configure three license servers that are named license1, license2, and
license3 to use port 27000, the default port, and port 1765 respectively, enter this text:
27000@license1;@license2;1765@license3

Click Next.
16. On the Summary page, review your choices before installing the product package. To change
the choices that you made on previous pages, click Back, and make your changes. When you are
satisfied with your installation choices, click Install to install the package.
A progress indicator shows the percentage of the installation that is completed.
17. When the installation process is complete, a message confirms the completion of the process.
a. Click View log file to open the installation log file for the current session in a new window.
You must close the Installation Log window to continue.
b. In the Install Package wizard, select whether to start the product when you exit.
c. Click Finish to start installing the selected package.
18. License the product.
See the License management on page 22 topics.

Installing Rational® Performance Tester Agent
You must install Rational® Performance Tester Agent on different computers to apply load on the server
that hosts the application under test.
You must have installed IBM® Installation Manager from the jazz website. For more information about
installing the product from the command-line interface in the silent mode, see IBM Installation Manager
Knowledge Centre.
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You must ensure that you have connected to the Internet.
If you use the Launchpad program to install the product, IBM Installation Manager is installed
automatically if you do not have it on your computer. After the installation is complete, IBM® Installation
Manager starts the product installation by using the preconfigured repository that contains the product
package.
If you install Installation Manager and then install the product, you must set the repository preferences
manually.
1. Perform one of the following steps to start the installation process:
a. To install the product from compressed files, such as .zip or ISO files:
i. Extract the files into a common directory.
ii. Navigate to Common_Directory/RPTAGENT_SETUP/
disk1/Platform_Directory.
iii. Double-click the install.exe file.
b. To install the product from a compact disc (CD):
i. Insert the product CD into the CD drive.
Note: If autorun is enabled on your computer, then the Launchpad program
starts automatically.
ii. Start the Launchpad program manually based on your operating system, if autorun is
not enabled on your computer:
• For

: Run the launchpad.exe command, that is located in the root

directory of the Setup disk installation image.
• For

: Run the launchpad.sh command, that is located in the root

directory of the Setup disk installation image.
• For

: Run the open Launchpad.app command from the root directory

of the Setup disk installation image.
Note: The Mac OS commands are case-sensitive.
2. Select a language in which you want to run the Launchpad program and Installation Manager.
3. Click a product package.
The description of the product package is displayed in the Details pane at the end of the window.
4. Optional: Click Check for Other Versions, Fixes, and Extensions to search for any updates to the
product packages.
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If updates for a product package are found, they are displayed in the Installation Packages list
under their corresponding product. Installation Manager displays only the recommended updates
by default.
5. Optional: Select the Show all versions checkbox to view all the updates that are available for the
packages.
You can click the package name to view the package description under the Details pane. If
additional information about the package is available, such as a readme file or release notes, a
More info link is included at the end of the description text. You can click the link to view additional
information in a browser.
Note: For Installation Manager to search the predefined IBM® repository locations for the
installed packages, you must select the Search service repositories during installation and
updates checkbox on the Repositories preference page. This checkbox stays selected as the
default value. A progress indicator shows the status of the ongoing process. You can install
updates simultaneously when you install the base product package.
6. Select the product package and its updates, install it on your computer, and then click Next.
Note: Updates with dependencies are automatically selected and cleared together. If you
install multiple packages simultaneously, all the packages are installed into the same package
group.
7. Read and understand the terms of all of the license agreements for the selected package, and then
perform the following steps:
a. Click I accept the terms in the license agreement.
b. Click Next to continue.
8. Select a location for the shared resources directory, and then click Next.
The shared resources directory contains resources that can be shared with one or more package
groups. You can either browse the location in the Shared Resources Directory field or enter the
path of the location for the shared resources directory.
The default path of the Shared Resources Directory are as follows:
• For

: C:\Program Files\IBM\IBMIMShared

• For

: /opt/IBM/IBMIMShared

• For

: /Applications/IBM/IBMIMShared

Remember: You can specify the shared resources directory only for the first time when you
install a package. You must use your largest disk for this directory. The largest disk ensures that
you have adequate space for the shared resources of future packages. You cannot change the
location of the directory unless you uninstall all packages.
9. Select one of the following options to use an existing or new package group:
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• Use the existing package group: You can use this package group if you update the product.
• Create a new package group: You can use this package group either to install or update the
product.
A package group represents a directory in which packages share resources with other packages in
the same group.
Note: The Use the existing package group option is disabled when you install a package for
the first time.
10. Perform the following steps to create a new package group:
a. Select Create a new package group.
b. Enter the path in the Installation Directory field for the package group.
The name for the package group is created automatically.
The default paths are as follows:
• For

: C:\Program Files\IBM\SDP

• For

: /opt/IBM/SDP

• For

: /Applications/IBM/SDP

c. Select 32-bit or 64-bit as Architecture Selection.
d. Click Next.
11. Click Next.
Rational® Performance Tester Agent does not support extending an existing Eclipse IDE.
12. Select the languages for the package group.
The corresponding translations for the user interface and documentation for the product package
are installed.
13. Select all the features that you want to install, and then click Next.
You can perform the following actions to install or view information about the features:
• Select the Windows desktop Application testing (Next Generation) and Appium Drivers
for Automated Testing checkboxes to install the execution agent which provides the
necessary prerequisites to test native and hybrid mobile applications, and Windows desktop
applications. The execution agent is installed along with Rational® Performance Tester
Agent on your computer.
Note: After the installation, you can set the environment variable to start the execution
agent automatically whenever you start Rational® Performance Tester Agent. For more
details, see the related links.
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• Select Show Dependencies to view the dependency relationships between features.
• Click a feature to view its brief description under Details.
Notes:
• The Load Generation Agent is used to generate a load on the system under test and gather
data for the Response Time Breakdown feature.
• Installation Manager automatically enforces any dependencies with other features and
displays updated download sizes and disk space requirements for the installation.
14. Perform the following steps to configure the agent:
a. Select Rational® Functional Tester Panel if you shell-share Rational® Performance Tester
with Rational® Functional Tester and run a UI test on the remote agent computers.
Notes:
• On Windows system, clear The agent will be used primarily to support remote
execution of UI tests from RFT checkbox if you are not running a UI test, so that
Majordomo runs as a service.
• On Linux and Mac operating systems, the The agent will be used primarily to support
remote execution of UI tests from RFT option is not available. The agent runs as a
service and can run a UI test. This is the default behavior.
• When Majordomo runs as a service, it starts the service automatically after the
computer is restarted. However, if you want to run the UI test on remote agent
computers, then you must select The agent will be used primarily to support remote
execution of UI tests from RFT checkbox so that after the installation of the agent is
complete, Majordomo runs as a batch file instead of a service.
• When Majordomo runs as a batch file, it stops after the computer is restarted. You
must restart Majordomo by double-clicking the AgentInstallDir/Majordomo/
Majordomo.bat file.
b. Select IBM Rational Load Generation Agent Configuration and perform the following steps:
i. Specify the values for the following parameters for Rational® Performance Tester:
Field name

Description

Workbench host

The hostname of Rational® Perfor

name

mance Tester.

Workbench port

The port number of Rational® Perfor

Example
localhost

7080

mance Tester.
ii. Specify the values of the following parameters for Rational® Test Automation Server:

19

Administrator Guide

Field

Description

name
Server

The hostname of Rational® Test Automation

Example
localhost

Hostname Server.
Server

The port number of Rational® Test Automation

Port

Server.

443

Server To An offline user token that is created from Ratio

eyJhbGciOi

ken

nal® Test Automation Server.

JIUzI1NiIsInR

Server

The name of the Server URL Alias that you pro

testteam

URL Alias

vided during the creation of the team space in
Rational® Test Automation Server.

c. Select IBM® Rational® Performance Tester Agent Configuration Panel and select the
product from the available list that is being installed with Rational® Performance Tester
Agent.
d. Click Next.
15. Review your choices, and then click Install.
You can click Back to change the choices that you made on previous pages and make your
changes.
A progress indicator shows the percentage of the installation that is complete.
16. Optional: Click View Log File to open the installation log file for the current session in a new
window.
Note: You must close the Installation Log window to continue.
17. Click Finish to exit the installation wizard.
You have installed Rational® Performance Tester Agent.
You can check the status of agents from the workbench. See Checking the status of agents on page
.

Installing Rational® Performance Tester Agent on an AIX 7.1 or later
IBM® Rational® Performance Tester Agent includes the Load Generation agent to generate load for
the application under test by using the virtual users, to gather data for the Response Time Breakdown
feature, and in support of the startup and control of web services stubs in the SOA protocol. When you
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install the Agent, the Data Collection Infrastructure application is also installed. This application is used to
instrument the servers for Response Time Breakdown.
By starting the installation process from the launchpad program, IBM® Installation Manager is
automatically installed if it is not already on your computer. Furthermore, Installation Manager starts
preconfigured with the location of the repository that contains the product package.
If you install and start Installation Manager directly, then you must set repository preferences manually. To
learn how to install the product from a command prompt in silent mode, see the Installing Silently section
in the Installation Manager Knowledge Center.
Note: Review the installation considerations on page 8 for the Rational® Performance Tester, if
you have not done so.
1. Log in as the root user before you begin installing the product.
2. If you are installing from compressed files, such as .zip or ISO files, extract the files into a common
directory. Extract the disk images to directories named /disk1, /disk2, and so on. Extract the Setup
disk image to a directory. The Setup disk contains the launchpad program.
3. Run the launchpad.sh file, which is located in the root directory of the Setup disk installation
image.
4. Select a language in which to run the launchpad and Installation Manager, and click OK.
5. Select the product to install from the launchpad menu. The Install Packages window opens.
6.
7. Click a product package to highlight it. The description of the package is displayed in the Details
pane at the end of the screen.
8. Optional: To search for updates to the product packages, click Check for Other Versions
and Extensions. If updates for a product package are found, then they are displayed in the
Installation Packages list on the Install Packages page under their corresponding products. Only
recommended updates are displayed by default.
9. Optional: To view all updates that are found for the available packages, click Show all versions.
10. Optional: To display a package description, under Details, click the package name. If additional
information about the package is available, such as a readme file or release notes, a More
information link is included at the end of the description text. Click the link to display the additional
information in a browser. To fully understand the package you are installing, review all information
beforehand.
11. Click Next to continue.
Note: If you install multiple packages at the same time, then all the packages are installed into
the same package group.
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12. On the Licenses page, read the license agreement for the selected package. If you select more
than one package to install, there might be a license agreement for each package. On the left side
of the License page, click each package version to display its license agreement. The package
versions that you select to install (for example, the base package and an update) are listed under
the package name.
13. If you agree to the terms of all the license agreements, click I accept the terms of the license
agreements; then click Next to continue.
14. On the Location page, type the path for the shared resources directory in Shared Resources
Directory, or accept the default path. The shared resources directory contains resources that can
be shared by one or more package groups. The default path is /opt/IBM/IBMIMShared. Click
Next to continue.
Note: You can specify the shared resources directory only the first time that you install a
package. Use your largest disk for this operation to help ensure adequate space for the shared
resources of future packages. You cannot change the directory location unless you uninstall all
packages.
15. On the Location page, create a package group to install the product package into, or, if this is an
update, use the current package group. A package group represents a directory in which packages
share resources with other packages in the same group. The default path is .
16. To create a package group, click Create a new package group, and then type the path for
the installation directory for the package group. The name for the package group is created
automatically. Click Next to continue.
17. On the Features page under Translations, select the languages for the package group. The
corresponding translations for the user interface and documentation for the product package will
be installed.
18. On the next Features page, select the package features to install and click Next.
19. On the next Features page, for Load Generation Agent, type the workbench host name. If you do
not want to use 7080 as the port number, change the port number. You can also change the port
number after you install Rational® Performance Tester Agent.
20. On the Summary page, review your choices and click Install.

License management
Licensing for your installed IBM® software and customized packages is administered through the
Manage Licenses wizard in the IBM® Installation Manager. The Manage Licenses wizard displays license
information for each installed package.
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Using the Manage Licenses wizard, you can apply a license to a product or upgrade trial versions of an
offering to a licensed version by importing a product activation kit. You can also enable floating license
enforcement for offerings with trial or permanent licenses to use floating license keys from a license
server.
For more information about managing licenses for your Rational® product, see these resources:
• Product Activation of Eclipse-based Rational products
• Rational licensing support
• Rational License Key Server Knowledge Center

License descriptions
As a purchaser of an IBM® Rational® software product, you can choose from four types of product
licenses:
• Authorized User licenses on page23
• Floating licenses on page24
• Token licenses on page24
• Processor value unit (PVU) licensing on page24
The best choice for your organization depends upon how many people use the product, how often they
require access, and how you prefer to purchase software.

Authorized User licenses
An IBM® Rational® Authorized User license authorizes an individual to use a Rational® software product.
You must obtain an Authorized User license for each individual user who accesses the product in any
manner. An Authorized User license cannot be reassigned unless you replace the original assignee on a
long-term or permanent basis.
For example, if you purchase one Authorized User license, you can assign that license to one individual
who can use the Rational® software product exclusively. The Authorized User license does not authorize
a second individual to use that product at any time, even if the licensed individual is not using the product.
Note: If you purchase IBM® Rational® Performance Tester as part of IBM® Rational® Test
Workbench, you do not require runtime licenses such as protocol key to run a schedule.
An IBM® Rational® Authorized User Fixed Term License (FTL) authorizes an individual to use a Rational®
software product for a specific length of time (the term). Purchasers must obtain an Authorized User
FTL for each individual user who accesses the product in any manner. An Authorized User FTL cannot be
reassigned unless the purchaser replaces the original assignee on a long-term or permanent basis.
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Note: When you purchase an Authorized User FTL under the IBM® Passport Advantage® Express®
program, IBM® automatically extends the license term for an additional year at the prevailing price unless
you notify IBM® before the license expires that you do not want an extension. The subsequent FTL term
starts when the initial FTL term expires. The price for this subsequent term is currently 80% of the initial
FTL price, but is subject to change.

Floating licenses
An IBM® Rational® Floating license is a license for a single software product that can be shared among
multiple team members; however, the total number of concurrent users cannot exceed the number of
floating licenses you purchase. For example, if you purchase one floating license for a Rational® software
product, any user in your organization can use the product at any given time. Another person who wants
to access the product must wait until the current user logs off.
To use floating licenses, you must obtain floating license keys and install them on a Rational® License
Server. The server responds to user requests for access to the license keys; the server grants access to
the number of concurrent users that equals the number of licenses the organization purchased.
Floating license enforcement provides these benefits:
• License compliance enforcement throughout the organization
• Fewer license purchases
• License keys served for IBM® Rational® Team Unifying and IBM® Rational® Software Delivery
Platform desktop products from the same license server
• Some versions of Rational® products require an upgraded version of the Rational® License
Server. See this support article for license upgrade information: http://www.ibm.com/support/
docview.wss?uid=swg21250404

Token licenses
The token-based license model means that you can buy a certain number of token licenses. If you use a
Rational® tool that checks out a feature that is token-based, the feature line in the license file specifies
the number of tokens that are checked out. Token-based licenses can only be used with floating licenses.
They cannot be used for authorized user license. For more details about token licensing, contact your
local IBM® marketing representative.

Processor value unit (PVU) licensing
Processor value unit (PVU) licensing is for providing you pricing structures that are responsive to both the
type and number of processors that are available to installed products.
Entitlements can be full capacity or subcapacity. Under the processor value unit licensing structure, you
license software based on the number of value units assigned to each processor core. For example,
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processor type A is assigned 80 value units and processor type B is assigned 100 value units. If you
license a product to run on two type A processors, you must acquire an entitlement for 160 value units. If
the product is to run on two type B processors, the required entitlement is 200 value units.
The processor value units table, which assigns a number of value units to each supported processor
type, is regularly updated to provide for the introduction of new processor technologies. Agents retrieve
information about the number and type of processor on the monitored computer or partition and the table
is used to determine the level of license use in terms of processor value units.
For more information about managing licenses for your Rational® product, see the IBM License Metric
Tool Knowledge Center to learn about processor value unit licensing.

Enabling licenses
If you are installing the software for the first time or want to extend a license to continue using the
product, you have options on how to enable licensing for your product.
Licenses for this product are enabled in two ways:
• Importing a product activation kit
• Enabling Rational® Common Licensing to obtain access to floating license keys

Activation kits
The Product Activation Kit CD contains the permanent license key for you product. You use IBM®
Installation Manager to import the activation kit to your product.
To enable the PVU licensing capability, download the PVU activation kit from the Rational® Common
Licensing server, unzip it, and use IBM® Installation Manager to import the activation kit.

Floating license enforcement
Optionally, you can obtain floating license keys, install IBM® Rational® License Server, and enable floating
license enforcement for your product. Floating license enforcement provides these benefits:
• License compliance enforcement throughout the organization
• Fewer license purchases
• License keys served for IBM® Rational® Team Unifying and Software Delivery Platform desktop
products from the same license server
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Note: Some 7.0 and later versions of Rational® products require an upgraded version of the
Rational® License Server. See this support article for license upgrade information: http://www.ibm.com/
support/docview.wss?uid=swg21250404
For more information about obtaining activation kits and floating licenses, see Purchasing licenses on
page 28.

Enabling runtime licenses for testing
To run tests, you must have the correct license keys installed.
IBM® Rational® Performance Tester requires two types of licenses: product activation and runtime
licenses. Product activation licenses permit you to run the product. Runtime licenses are unique to
Rational® Performance Tester. Runtime licenses consists of protocol keys and virtual tester license key
packs. Runtime licenses permit you to run performance tests on specific protocols with multiple virtual
users. You use different tools to manage and configure product activation licenses and runtime licenses.
You manage product activation by using Installation Manager. You manage runtime licenses by using
IBM® Rational® License Key Administrator.
With product activation licenses, you can start the product. There are two forms of product activation
licenses: a product activation kit that is installed on the computer where the product is installed or a
floating product license that users check out from a Rational® License Server. You can download the
product activation kit from IBM® Passport Advantage® for authorized user purchases. For floating
product licenses, your license server administrator must log in to the Rational® License Center to
download a floating license key and import it to your Rational® License Server. Make sure to use the
version of Rational® License Server that comes with the product. Earlier versions of Rational® License
Server might not support all the required licensing functions. For more information about the Rational®
License Server, see Managing licenses with Rational® Common Licensing on page

.

The Rational® License Server supports floating license keys, so that administrators can manage licensing
throughout the enterprise. Administrators can install the Rational® License Server from Passport
Advantage® or from the product media. To learn more about product activation, including the Rational®
License Server, see the product installation guide.
In addition to product activation, Rational® Performance Tester also checks for runtime licensing when
you run a performance schedule. Runtime licensing consists of the correct protocol keys and virtual
tester license key packs. You must have a protocol key to run performance tests with any protocol other
than HTTP. You must have a virtual tester license key pack to run tests with more than five virtual users.
You can check out these keys from the same Rational® License Server that you use for floating license
product activation.
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To check out protocol and virtual tester license keys in Windows™, you must use the IBM® Rational®
License Key Administrator program to point to a Rational® License Server. Use the version of IBM®
Rational® License Key Administrator that was installed with Rational® Performance Tester. Click Start
> Programs > IBM Rational > License Key Administrator 8.2.1. Type the name or IP address of your
Rational® License Server. Protocol and virtual tester license keys are available from the Rational®
License Key Center in the form of .upd files. If you double-click a .upd file in Windows™, the License
Key Administrator program starts automatically and imports the license keys. To learn more about IBM®
Rational® License Key Administrator, click Help > Contents and Index.
There is no Linux™ version of the IBM® Rational® License Key Administrator. To check out protocol
and virtual tester license keys in Linux™, you must create and edit the .flexlmrc file. Create the file
.flexlmrc in the home directory of every user who runs more than five virtual testers, uses a protocol
other than HTTP, or uses the floating license product activation. Edit the .flexlmrc file, adding a line
with the computer name or the IP address of the Rational® License Server. For example, add the line
RATIONAL_LICENSE_FILE=@license-server-name.com or RATIONAL_LICENSE_FILE=@license-server-ipaddress.

Runtime license examples
To run tests, you must have the correct license keys installed.
The trial licensing key permits you to run Rational® Performance Tester for 30 days from the initial
installation. After 30 days from the first time you install the product, the trial license expires.
The following table shows the number of virtual users you can use, depending on the license keys that
you have installed:

Protocol

Trial license

Perma

Permanent with

nent license

Protocol key

500-user virtual
tester key pack
and protocol key

HTTP

5

5

n/a

505

Siebel

5

1

5

505

SAP(GUI)

5

1

5

505

SAP(Web)

5

1

5

505

Citrix

5

1

5

505

TN3270

5

5

n/a

505
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Protocol

Trial license

Perma

Permanent with

nent license

Protocol key

500-user virtual
tester key pack
and protocol key

Socket

5

5

n/a

505

SOA

5

1

5

505

Purchasing licenses
You can purchase new licenses if your current product license is about to expire or to acquire additional
product licenses for team members.
1. Determine the type of license to purchase.
2. Go to ibm.com® or contact your IBM® sales representative to purchase the product license. For
details, visit the IBM® web page on How to buy software on page

.

3. Depending on the type of license you purchase, use the Proof of Entitlement that you receive and
complete one of these steps to enable your product:
• If you purchase Authorized User licenses for your product, go to Passport Advantage® on
page

, and follow the instructions there for downloading your product activation kit.

After you have downloaded the activation kit, import the product activation .jar file by
using IBM® Installation Manager.
Back up the product activation .jar file. If you uninstall the product and then install the
product again, you might need to use the product activation .jar file to license the product
again.
• If you purchase floating licenses for your product, go to the IBM® Rational® Licensing and
Download Center on page

, and then click the link to connect to the IBM® Rational®

License Key Center. There you can use your Proof of Entitlement to obtain floating license
keys for your license server.
Optionally, you can go to IBM® Passport Advantage® to download the activation kit for your
product. After importing the activation kit, you can switch from a floating to a permanent
license type if you use your computer offline for long periods.
To import the activation kit or enable floating license support for your product, use the Manage Licenses
wizard in IBM® Installation Manager.
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Viewing license information for installed packages
You can review license information for your installed packages, including license types and expiration
dates, from IBM® Installation Manager.
1. Start IBM® Installation Manager.
2. On the main page, click Manage Licenses.
The package vendor, current license types, and expiration dates are displayed for each installed package.

Upgrading and migrating
You cannot upgrade to the latest version of the product. You must first uninstall the existing version of the
product before you install the latest version of the product.

Migrating test assets to new version of the product
After you install a later version of the product and you choose to open the product from an old workspace,
you are prompted to migrate test projects, tests, schedules, rules, and reports. Tests and schedules are
migrated automatically when you modify and save them.
You cannot have two versions of the products installed on your computer at one time. Before you
install a new version, uninstall the previous version of the product. If you update the product with IBM®
Installation Manager, you do not have to uninstall the previous version. Uninstalling a previous version
does not delete your test assets.
Note: When you want to uninstall the previous version of the product and then install the latest
version, you must install the latest version in the same folder that contained the previous version. Thereby,
you can avoid compilation errors in the project in the latest version.
When you open a project that contains an older test asset, a message is displayed in the Test Navigator
view. Typically, you upgrade your tests, schedules, and rules.

Important: Ensure that you back up the test assets before upgrading them for the new version of the
product. Do not open a migrated test project with a previous version of the product.

29

Administrator Guide

If you leave tests, schedules, and rules unchanged, they will not have the new functions that current
release adds. You can always save a modified test asset under a new name, which preserves the older
asset. You can identify an older asset by its version, which is listed in brackets:

Note: A new release might include enhancements to the default reports. When you run a test or
schedule or open a report, you are prompted to upgrade reports to the latest version. If you upgrade the
default reports to the latest version, you lose customizations that you have made to the reports.
If you encounter errors when you open a workspace from a different version of the product, reset the
perspective. To reset the perspective, click Window > Reset Perspective.

Configuring
Use these topics to configure the product.

Configuring the environment for SAP tests
Some of the capabilities of service tests require that you manually install additional libraries and files or
that you configure some elements of the test environment.

Configuring SAP for performance testing
Performance test recording and execution requires scripting to be enabled on the SAP application server
and on all SAP GUI clients that are installed on remote computers. The instructions might vary based on
the SAP versions that you use.
Performance testing relies on the SAP Scripting API and ActiveX. Make sure that Active X is installed
when installing the SAP GUI client and enable scripting on the SAP server.
Note: You only need to perform the following actions once. Scripting should remain enabled on the
SAP server after a restart.
To enable scripting on the SAP server:
1. Check that there is a Scripting directory located in the SAP GUI installation directory.
If this directory does not exist, then the SAP Scripting API is not installed and you must reinstall
SAP GUI with the SAP Scripting API option.
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2. Run the SAP GUI client and logon to SAP with your user name and password.
Administrator privileges might be required to enable scripting on the server.
3. In SAP, run the transaction rz11, type the parameter name sapgui/user_scripting, and then click
Display.
If the parameter is not found, then make sure you have the correct support package level from SAP.
Contact your SAP representative for guidance.
4. If the Current value is FALSE, click the Change value button, and then set the New value to TRUE in
uppercase characters.
5. Click Save, and then end the transaction.
Scripting will be enabled the next time you log on.
6. In the SAP GUI client toolbar, click the Customizing of Local Layout toolbar button, and then select
Options.
The SAP GUI Options page is displayed.
7. Expand Accessibility & Scripting from the left pane.
8. Select the Scripting page.
9. Select the Enable scripting check box, and then disable both Notify when a script attaches to SAP
GUI and Notify when a script opens a connection.
10. Click OK.
11. In the Help menu, select Settings, and then select the F4 Help page.
12. In Display, select Dialog (modal) and then click the Enter

button.

Repeat steps 5 through 10 for SAP GUI clients on all remote computers. For more information about
enabling scripting on the SAP application server, refer to the following SAP notes, available from SAP:
• 480149: ABAP and patch level requirements
• 587202: Limitations of SAP GUI Scripting
• 527737: Composite SAP Note on SAP GUI Scripting
• 612454: SAP GUI Scripting status and lifetime
• 619459: SAP GUI Scripting support of SAP applications

Related information
Configuring an environment for batch input tests on page31
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Configuring an environment for batch input tests
To play back the SAP batch input tests, you must configure the environment by installing the SAP Java™
Connector (JCo) libraries provided by the SAP administrator on local and remote computers where the
IBM® Rational® Performance Tester Agent is running.
• You must have downloaded the following files provided by the SAP administrator:
◦ sapjco3.jar
◦ sapjco3.dll
For more information about downloading the SAP files, refer to the SAP portal.
Note: You must have verified that the Microsoft® Visual Studio 2013 C/C++ runtime libraries
are installed on your computer. If the runtime libraries are not present in your computer, then you
must download and install the latest version of the Visual C++ 2013 Redistributable Package from
Microsoft Download Center, depending on the Windows operating system (For example, Windows
32-bit or Windows 64-bit). For more information about the redistributable packages, refer to the
Microsoft support portal.
• You must have performed the following actions on each local and remote computer that is used
for running the batch input tests and schedules:
◦ Prepared an environment with the libraries that you have downloaded from the SAP portal.
◦ Set the class path of the Java™ Runtime Environment (JRE) to a value that is used by
Rational® Performance Tester Agent.
1. Copy sapjco3.jar into the jre/lib/ext directory of the JRE.
The default directory is: C:\Program Files\IBM\SDP\jdk\jre\lib\ext.
2. Copy sapco3.dll into the system directory.
For example,
• If you are using a Windows 32-bit, you must copy the sapco3.dll file into the C:
\Windows\System32 directory.
• If you are using a Windows 64-bit machine, you must copy the sapco3.dll file into the C:
\Windows\SysWOW64 directory.
3. Click Start > Control Panel > Administrative Tools > Services, and then stop and restart the
Majordomo service, if you are using an IBM® Rational® Performance Tester agent.
The environment for the SAP batch input test is configured and as a result, the SAP Batch Input
Recording option is available for selection on the Select Client Application page.
After the configuration is complete, you can then select the SAP Batch Input Recording option, and runs
a SAP batch input test. You can then verify the test results from the Batch Input Transaction Rate page
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of the SAP performance report. You can also view the Test Log page to verify the SAP connection and
transaction execution information.

Related information
Configuring SAP for performance testing on page30
Recording a SAP batch input test on page

Configuring the data collection infrastructure
If you want to collect response time breakdown data from remote computers used in distributed
applications, you must install and configure the data collection infrastructure on the remote computers.

Data collection infrastructure overview
The data collection infrastructure collects performance profiling data for distributed applications and
sends the data to the workbench computer, where you can view and analyze the collected data. The data
collection infrastructure must be installed, configured, and running on all remote computers that will
be used in your distributed application. The data collection infrastructure is installed when you install
Rational® Performance Tester Agent.
You can monitor a live application in a development or testing environment and collect data from the
application in real time. Data collection is supported on the following web servers:
• IBM® WebSphere® Application Server, Version 6.1, 7.0, 8.0, or 8.5 running on Microsoft™
Windows™, AIX®, and Linux™
• Oracle WebLogic Application Server, Version 9 or 10 running on Microsoft™ Windows™ and Linux™
You can also query IBM® Tivoli® Monitoring for Transaction Performance, IBM® Tivoli® Composite
Application Manager for Response Time Tracking, IBM® Tivoli® Composite Application Manager
for WebSphere® or IBM® Tivoli® Composite Appliciuiu.uation Manager for Application Diagnostics
management server databases to collect past performance data for an application that is deployed in a
production environment. Data collection is supported on the following software versions:
• IBM® Tivoli® Monitoring for Transaction Performance, Version 5.3 fix pack 1 (5.3.0.1)
• IBM® Tivoli® Composite Application Manager for Response Time Tracking, Versions 6.0 and 6.1
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• IBM® Tivoli® Composite Application Manager for WebSphere®, Versions 6.0 and 6.1
• IBM® Tivoli® Composite Application Manager for Application Diagnostics, Version 7.1

Related information
Instrumenting local servers on page34
Instrumenting servers by using the command prompt on page38
Removing instrumentation on page39
Removing instrumentation using the command prompt on page40

Instrumenting local servers
You must instrument application servers to collect response time breakdown data. You can use either
a command-line or graphical user interface to instrument application servers to work with the data
collection infrastructure.
• The data collection infrastructure must be installed on any computer from which you want to
collect performance data.
• If you are instrumenting a WebSphere® application server, the application server must be running.
• The Application Server Instrumenter prompts you to restart BEA WebLogic application servers.
• You must have root or administrator user privileges to instrument servers.
1. In Windows™, click Start > Programs > __BRAND_NAME__ Data Collection Infrastructure >
Application Server Instrumenter.
In Linux™, use the start menu to open the Application Server Instrumenter. In the AIX® operating
system, type /opt/IBM/SDP/DCI/rapa_prod/instrument_comp/ASI at a command prompt to start
the Application Server Instrumenter.
The Application Server Instrumenter starts.
2. Use the Application Server Instrumenter to instrument the server. See the examples that follow.
3. If you are instrumenting a BEA WebLogic server, after you have instrumented the server you must
restart the application server.
The Application Server Instrumenter automatically restarts WebSphere® application servers.
Note: All IBM® Rational® Performance Tester systems that are involved with the data
collection infrastructure must have the data collection software running for the transaction
breakdown function to be available within the results of a Rational® Performance Tester test
schedule.
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Note: The application server instrumenter or the instrumentServer.bat (or
instrumentServer.sh) batch file can fail with a generic error message (Error during install/
uninstall) when instrumenting or uninstrumenting a server. If this error occurs, you can find more

information to help troubleshoot the error in the log files in the IBM® Tivoli® common directory.
On Windows™, the default location of this directory is C:\Program Files\IBM\tivoli
\common. On Linux™, the default location of this directory is /var/ibm/tivoli/common. If
the IBM® Tivoli® common directory is not in the default location, search for a path that contains
tivoli/common, or for any of these log files: trace-install.log, trace-ma.log, or tracetapmagent.log.
Note: For IBM® WebSphere® Application Server 6.0 or later, if you create a new profile
and then use the application server instrumenter to instrument this profile without first starting
WebSphere® Application Server, the application server instrumenter reports that the server is
instrumented and prompts you to restart the server manually. This message is incorrect; the server
is not actually instrumented. To work around this problem, complete these steps:
a. Close and then restart the application server instrumenter.
b. Select the entry that you just added from the list of instrumented servers, and click Remove.
c. Restart WebSphere® Application Server.
d. Restart the application server instrumenter, and use it to instrument the server.
To avoid this problem, after you create a new profile, start the WebSphere® Application Server
profile manually. Then, use the application server instrumenter to instrument the server.
To instrument a Linux™ computer that is equipped with the 64-bit version of IBM® WebSphere®
Application Server, Version 6.1, where the server is named server2, the server is installed in the /opt/
WebSphere/AppServer directory, with the profile name set to the default value, and security enabled:
1. Click Instrument Local Server.
2. From the Type list, select IBM WebSphere Application Server v6.1.
3. Type /opt/WebSphere/AppServer in the Server home field.
4. Type server2 in the Server name field.
5. Type default in the Profile name field.
6. Under Server JVM, click 64-bit.
7. Select the Requires global security check box.
8. Type the WebSphere® user ID in the User field.
9. Type the WebSphere® password in the Password field.
10. Click OK.
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To instrument a Microsoft™ Windows™ computer that is equipped with a BEA WebLogic 10 application
server named server1 that is installed in the C:\bea\weblogic10 directory, using the 32-bit version of
JRockit JVM, and the C:\bea\weblogic10\mydomain\startWebLogic.cmd start script file :
1. Click Instrument Local Server.
2. Select BEA WebLogic Application Server v10.x from the Type list.
3. Type server1 in the Server name field.
4. Type C:\bea\weblogic10 in the Server home field.
5. Type C:\bea\weblogic10\mydomain\startWebLogic.cmd in the Start script field.
6. Under Server JVM, select Oracle JRockit 32-bit.
7. Click OK.
8. Stop and restart the server.
Repeat the instrumentation steps for every application server that is involved in data collection for the
applications that you will profile. Typically, there will be only one application server. You can instrument
only one local application server per computer.

Related information
Data collection infrastructure overview on page33
Instrumenting servers by using the command prompt on page38
Removing instrumentation on page39
Removing instrumentation using the command prompt on page40

Tips for instrumenting Oracle WebLogic Application Server
Tips when instrumenting Oracle WebLogic Application Server to collect response time breakdown data.
• You must instrument using an account with root or administrator privileges.
You must provide correct information in the Application Server Instrumenter.
Server name is the name of the server to instrument. For example, for Oracle WebLogic Application Server
10.3 running on Microsoft™ Windows™ with the default sample application MedRec installed, the server
name is MedRecServer.
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Server home is the path to the server bin directory. For example, for Oracle WebLogic Application Server
10.3 running on Microsoft™ Windows™ with the default sample application MedRec installed, the server
home is: C:\Oracle\Middleware\wlserver_10.3\samples\domains\medrec.
Start script is the script, a .cmd or .sh file, used to start the Oracle WebLogic Application Server.
For example, for Oracle WebLogic Application Server 10.3 running on Microsoft™ Windows™ with
the default sample application MedRec installed, the start script is C:\Oracle\Middleware
\wlserver_10.3\samples\domains\medrec\bin\startWebLogic.cmd.
Server JVM is the type of Java™ Virtual Machine (JVM) used by Oracle WebLogic Application Server. To
determine the server JVM, examine the system processes while the server is running and see whether the
JRockit JVM or the Oracle JVM is active.

Tips for instrumenting WebSphere® Application Server
Follow these tips when you instrument WebSphere® Application Server to collect response time
breakdown data.
• The instance of WebSphere® Application Server to instrument must be running.
• You must instrument with an account with root or administrator privileges.
• If security is enabled for WebSphere® Application Server, you must know the WebSphere®
Application Server administrator ID and password before you can instrument the server.
• Vertical clusters are not supported. You can instrument a horizontal cluster by instrumenting each
physical server separately.
You must provide correct information in the Application Server Instrumenter.
Server home is the complete path to the WebSphere® Application Server installation directory. By default,
on Microsoft™ Windows™ the server home is C:\Program Files\IBM\WebSphere\AppServer. In
Linux™ and AIX®, the default server home is /opt/IBM/WebSphere/AppServer.
Server name is the name of the WebSphere® Application Server instance to instrument. To see a list
of server names, change to the bin directory, and type this command at a command prompt: wsadmin
-conntype none -c "puts stdout [$AdminConfig list Server]".

An example of output from this command is as follows:
WASX7357I: By request, this scripting client is not connected to any server process.
Certain configuration and application operations will be available in local mode.
server1(cells/MachinenameNode01Cell/nodes/MachinenameNode01/servers/server1|
server.xml#Server_1183122130078)
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In this case, server1 is the server name.
Profile name is the name of the profile that is associated with the server to instrument.
To see a list of profiles from WebSphere® Application Server, change to the bin directory, and type this
command at a command prompt: manageprofiles -listProfiles. By default, in Microsoft™ Windows™
the bin directory is C:\Program Files\IBM\WebSphere\AppServer\bin. In Linux™ and AIX®, the
default bin directory is /opt/IBM/WebSphere/AppServer/bin.

Instrumenting servers by using the command prompt
You must instrument application servers to collect response time breakdown data. You can use either
a command prompt or graphical user interface to instrument application servers to work with the data
collection infrastructure.
The data collection infrastructure must be installed on each computer from which you want to collect
performance data. The application server must be running. You must have administrator or root user
privileges to instrument servers.
1. Open a command prompt, and go to the instrument_comp folder in the directory where the data
collection infrastructure is installed.
By default, in Microsoft™ Windows™, this directory is C:\Program Files\IBM\SDP\DCI
\rapa_prod\instrument_comp. In Linux™ and IBM® AIX®, this directory is /opt/IBM/SDP/
DCI/rapa_prod/instrument_comp.
2. Type the command name with the arguments to use to instrument a server. See the examples that
follow.
The instrumentation utility is instrumentServer.sh on AIX® and Linux™ systems and
instrumentServer.bat on Windows™ systems. Enter the command name with no arguments
to see the syntax details for the command.
3. After you have instrumented the application server, you might have to restart the application server.
Instrumentation changes take effect after the application server is restarted.
Assume that you must instrument a Windows™ computer that is configured as follows:
• IBM® WebSphere® Application Server, Version 7.0.
• The server is named my_Server2.
• The application server is installed in the C:\Program Files\was7.0 directory.
• The profile name is default.
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• Security is enabled.
• The server Java™ Virtual Machine (JVM) is a 64-bit JVM.
Type the following command and arguments:
instrumentServer -install -type was7 -serverName my_Server2 -serverHome "C:\Program Files
\was7.0" -serverVMArch 64 -user my_WAS_userId -password my_WAS_password -profileName default

To instrument a Linux™ computer that is equipped with a BEA WebLogic 10 application server, with
configuration details as indicated, using the 32-bit version of JRockit JVM, type the following command
and arguments:
./instrumentServer.sh -install -type wls10 -serverName server1 -serverHome /opt/bea/
weblogic10 -serverVM oracle -serverVMArch 32 -startScript /opt/bea/weblogic10/mydomain/
startWebLogic.sh

To instrument a Liberty Profile, for -type use liberty85, and for -serverHome use the path to the Liberty
server installation directory until wlp.
Repeat the instrumentation steps for each application server that is involved in data collection for the
applications that you will profile. Typically, there will be only one application server. You can instrument
only one local application server per computer.

Related information
Data collection infrastructure overview on page33
Instrumenting local servers on page34
Removing instrumentation on page39
Removing instrumentation using the command prompt on page40

Removing instrumentation
Before you uninstall the data collection infrastructure, you must remove instrumentation from all
application servers that were instrumented to work with the data collection infrastructure.
To remove the instrumentation from an application server:
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1. Click Start > Programs > __BRAND_NAME__ Data Collection Infrastructure > Application Server
Instrumenter.
On the IBM® AIX® operating system, type /DCI/rapa_prod/instrument_comp/ASI at a command
prompt to start the Application Server Instrumenter.
2. Select the server to remove the instrumentation from.
3. Click Uninstrument Server.
4. Restart the server if prompted to do so.
You can uninstall the data collection infrastructure.

Related information
Data collection infrastructure overview on page33
Instrumenting local servers on page34
Instrumenting servers by using the command prompt on page38
Removing instrumentation using the command prompt on page40

Removing instrumentation using the command prompt
Before you uninstall the data collection infrastructure, you must remove instrumentation from all
application servers that were instrumented to work with the data collection infrastructure.
If you have uninstalled the application server or removed an instance of the application server, you cannot
use the instrumentation utility to remove instrumentation from the server. This situation will block the
data collection infrastructure uninstall process. Do not uninstall an application server before you have
removed instrumentation from the application server.
Instrumented servers are listed in the file InstrumentationRegistry.xml. After you have removed
instrumentation from a server, the InstrumentationRegistry.xml file will be empty of references to
any application server. If you uninstall an application server before you have removed instrumentation, to
uninstall the data collection infrastructure you must edit InstrumentationRegistry.xml to remove
the applicationServer element for the application server that you uninstalled.
To remove instrumentation from application servers:
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1. Open a command prompt, and change directories to the instrument_comp folder in the data
collection infrastructure installation directory. By default, on Microsoft™ Windows™ this directory
is C:\Program Files\IBM\SDP\DCI\rapa_prod\instrument_comp. On Linux™ and IBM®
AIX®, this directory is /opt/IBM/SDP/DCI/rapa_prod/instrument_comp.
2. Type the command name with the -uninstall argument and all of the other arguments that you
used when instrumenting the server.
The instrumentation utility, which is also used to remove instrumentation from servers, is
instrumentServer.sh on AIX® and Linux™ systems and instrumentServer.bat on
Windows™ systems. Enter the command name with no arguments to see the syntax details for the
command.
3. Restart the server if prompted to do so.
You can uninstall the data collection infrastructure.

Related information
Data collection infrastructure overview on page33
Instrumenting local servers on page34
Instrumenting servers by using the command prompt on page38
Removing instrumentation on page39

Configuring Docker containers
Instead of reading through system requirements list and installing the products, you can now deploy the
Docker containers on any computer and get started with testing. To automate playing back tests, you can
push the product images to the Docker container.
1. Download and install Docker-CE. For more information, see the following links:
• Windows - https://store.docker.com/editions/community/docker-ce-desktop-windows.
• Ubuntu - https://docs.docker.com/install/linux/docker-ce/ubuntu/.
• Others - https://store.docker.com/search?type=edition&offering=community.
2. To verify whether your Docker installation was successful, open PowerShell or a terminal of your
choice and run:
$ docker run hello-world

3. Download the container image for the agents from the same location you downloaded the product
bits and extract the compressed files.
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Important: The version of the workbench and agents must match.
4. Load the agent image into the Docker repository:
$ docker load -i "imageFileName.tar.gz"

When the image is loaded, the following message is displayed - Loaded image:
imageFileName:versionNumber

You can now set up the playback environment on Docker by following instructions in Running tests with
containerized agents on page
agents from Docker on page

and Running automated tests with containerized workbench and
.

Configuring IBM® Cloud Private
To make use of automated workflows in IBM® Cloud Private, you can install it and push the Docker
containers to it.
You must use IBM® Cloud Private 2.1.0.3.
1. Install and set up IBM® Cloud Private-CE.
For more information, see documentation.
2. Install the IBM® Cloud Private Command Line Interface (CLI).
For more information, see documentation.
3. Download the IBM® Rational® Performance Tester and IBM® Rational® Performance Tester
Agent container images from the same location you downloaded the product bits.
The images are in the form of Passport Advantage (PPA) files. You can load the PPA files directly
to IBM® Cloud Private instead of extracting the Docker image out of it.
4. Load the images into Docker repository:
For Windows, use the command in GitBash:
$ docker load -i "imageFileName.tar.gz"

For Linux, use the terminal:
tar --wildcards --to-command='docker load' -xzf imageName 'images/*'

Note: The imageName can be the agent image ibm-rpta-9.2.1.tar.gz or the workbench
image.
When the image is loaded, following message is displayed - Loaded image:
imageFileName:versionNumber
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5. Before pushing the Docker image to IBM® Cloud Private cluster, configure the authentication from
Docker CLI. For more information, see the documentation.
6. Load the images to the IBM® Cloud Private cluster by using any of the following methods:
a. Use Docker to log in to the cluster and push the image:
i. To log in from your client system to the private image registry:
$ docker login cluster_CA_domain:8500

ii. To tag the images:
$ docker tag imagename:tagname cluster_CA_domain:8500/namespacename/imagename:tagname

iii. To push the images to the cluster:
docker push cluster_CA_domain:8500/namespacename/imagename:tagname

b. Use the IBM® Cloud Private CLI to push the images:
bx pr load-ppa-archive --archive ibm-rpta-imageVersion.tar.gz

bx pr load-ppa-archive --archive ibm-rtw-imageVersion.tar.gz

You can now set up the playback environment in IBM® Cloud Private. See Running automated tests
with containerized agents on IBM Cloud Private on page

and Running automated tests with

containerized workbench and agents on IBM Cloud Private on page

.

Integrating
Read these topics to learn how the product works when integrated with other products.

Testing with Engineering Workflow Management
You can manage test assets with Jazz™ source control management by integrating the test workbench
with IBM® Engineering Workflow Management (formerly known as Rational Team Concert) eclipse client.

Introduction
You can use Engineering Workflow Management eclipse client to connect to compatible Jazz™
servers, including Engineering Workflow Management servers. You must have a compatible version
of Engineering Workflow Management server setup to use Jazz™ source control management. For
information about compatible versions, see System Requirements on page

.

Use this feature to do the following tasks:
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• Access Engineering Workflow Management eclipse client.
• Manage the test assets by using Jazz™ source control management.
If you have installed the Engineering Workflow Management eclipse client, see the Getting Started
section of the Engineering Workflow Management help to learn more about using Engineering Workflow
Management .
To access work items, you can switch to the Work Items perspective by clicking Window > Open
Perspective > Work Items.

Installing Engineering Workflow Management client
You must have a Jazz.net account to download and install Engineering Workflow Management or
Rational Team Concert. You can register for a Jazz.net account at https://jazz.net/pub/user/register.jsp
and then, download Engineering Workflow Management or Rational Team Concert eclipse client
(extension install) from the Jazz site.
Notes:
• From V7.0 or later, Rational Team Concert is renamed to Engineering Workflow Management .
• Rational® Performance Tester or Rational® Service Tester for SOA Quality V10.1.1 are compatible
with Rational Team Concert V6.0.3 to 6.06 and Engineering Workflow Management V7.0.1.
Tips:
• You must install Engineering Workflow Management or Rational Team Concert by using IBM®
Installation Manager in the same package group as the test workbench.
• Both the Engineering Workflow Management or or Rational Team Concert client and the test
workbench must use the same workspace.
To find the appropriate Engineering Workflow Management or Rational Team Concert IM extension
installer, perform the following steps:
1. Access the Engineering Workflow Management Download page from https://jazz.net/downloads/
workflow-management or Rational Team Concert Download page from https://jazz.net/
downloads/rational-team-concert.
2. Click on the required version that you want to download.
3. Select the All Downloads tab to view other download options, including an extension or offline
(local) installers, and then search for extension install.
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Note: Rational Team Concert V6.0.3, V6.0.4, and V6.0.5 are listed as Client for Eclipse 4.2.x
IDE (Extension Install) instead of Client for Eclipse 4.x IDE (Extension Install) in the Jazz site.
However, it is listed as Client for Eclipse 4.x IDE for all the supported versions of Rational Team
Concert in the Installation Manager wizard.

Tracking defects with Engineering Workflow Management
You can submit defects to Engineering Workflow Management from Rational® Performance Tester. By
default, the test log editor uses Bugzilla as the defect tracking site. You must configure the product to use
Engineering Workflow Management for defect tracking.
1. Click Window > Preferences > Test > Test Log Editor.
The Test Log Editor preferences window opens.
2. Specify the URL of Engineering Workflow Management server in the Submit URL, Search URL, and
Open URL fields.
Contact the administrator of the Engineering Workflow Management server for more information.
The following are the example of URLs, where the name of the Engineering Workflow Management
server is evm.example.com and the name of the project is projectname:
Table 1. Example of EVM Server URL
Field
names

Field values

Sub

https://ewm.example.com:9443/jazz/web/projects/project-

mit

name#action=com.ibm.team.workitem.newWorkItem

URL
Search https://ewm.example.com:9443/jazz/web/projects/projectURL

name#action=jazz.viewPage&id=com.ibm.team.workitem

Open

https://ewm.example.com::9443/jazz/web/projects/project-

URL

name#action=com.ibm.team.workitem.viewWorkItem&id=

Note: You must change the URLs, if there is change in name of the Engineering Workflow
Management server.
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Related information
Test log overview on page

Testing with Engineering Test Management
By integrating IBM® Engineering Test Management (formerly known as IBM® Rational® Quality Manager)
with the product, you can initiate the test runs from Engineering Test Management. Read these topics to
learn about how to configure Engineering Test Management.

Engineering Test Management integration overview
To run tests from IBM® Engineering Test Management, you must configure the adapter that is installed by
default when you install the product.
The adapter can be run in three modes:
• In GUI mode, from within the test workbench itself
• From the command line
• As a Windows™ service
Note: The term test workbench refers to either Rational® Performance Tester, Rational® Service
Tester for SOA Quality, or Rational® Test Workbench.

Using Engineering Test Management
See the Rational® Quality Manager Knowledge Center for detailed information about using Engineering
Test Management.

Viewing results
When you run a test script from Engineering Test Management, the default report that is displayed during
a test run is attached to the Engineering Test Management results. This report can be customized. See
Customizing reports on page

for more information.

If you use Engineering Test Management version 4.0 or later, you can view and analyze the test reports in
Engineering Test Management. You can analyze the test reports while the test is in running state and after
the run is completed. To view the test reports in Engineering Test Management, in the Execution Results
dialog box click Analyze Results Interactively using Rational® Performance Tester .
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Note: To access reports from outside workbench, you must enable the remote access from
workbench. For more information, see the Access reports remotely on page

topic.

The result completion state that is reported to Engineering Test Management reflects the overall verdict
of the test log that is associated with the run. See Test log overview on page

for more information.

In many cases a test might contain a failed verification point, but still be considered as passed. View the
attached report in the Engineering Test Management execution result and set the execution results status
accordingly.
You can view the full run results from within the test workbench by opening the test workbench in the
workspace that is configured to be used by the adapter.
If the adapter is running from the command line or as a Windows™ service, stop the adapter before
opening the test workbench. When the workbench is opened, you can access the full test reporting and
test log capabilities. Results for runs that are initiated from Engineering Test Management are under the
Engineering Test Management Results project.
For Rational® Performance Tester schedules, the result completion state that is reported to Engineering
Test Management is based on the overall Requirements status. Only performance and functional
requirements for the last user stage that is defined in the schedule are covered by the report. If no
requirements are specified, the result completion state in Engineering Test Management is set to
inconclusive. In this case, view the attached performance reports and manually set the completion
state in Engineering Test Management. See Defining requirements in schedules on page

for more

information.

Known limitations
• Running tests from Engineering Test Management with encrypted data pools is not supported.
Password prompting when using such a dataset is not done in the adapter service or in the
command-line mode. This is also discouraged in the GUI mode, because it requires user interaction
with Rational® Performance Tester for a run initiated from the Engineering Test Management Web
user interface.
• Start only one adapter per product installation on a given computer. Using multiple adapters on
the same computer requires that you install each product as its own software package in its own
directory. If you are running multiple adapters on the same computer, ensure that they are using
different workspaces.
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Related information
IBM Engineering Test Management overview on page
Configuring the Engineering Test Management adapter on page48
Starting and stopping the Engineering Test Management adapter in the workbench on
page50
Starting and stopping the Engineering Test Management adapter from the command line on
page51
Starting and stopping the Engineering Test Management adapter as a Windows service on
page52
Importing test assets into Engineering Test Management on page54

Configuring the Engineering Test Management adapter
Before running the tests from IBM® Engineering Test Management, you must configure the Engineering
Test Management adapter so that you can establish a successful connection.
To configure the Engineering Test Management adapter, you must have the following information:
• The URL of the Engineering Test Management server.
• A login and password to access a user account in Engineering Test Management. This user
account must exist in Engineering Test Management with a Connector Client Access License. The
user account must also be added to the project area being accessed by the adapter, with a role
granting write permissions to the project. The default Test Team Member role is recommended.
For information about creating user accounts, see the Engineering Test Management Knowledge Center.
1. In the test workbench, click Window > Preferences > Quality Manager Adapter.
a. In Server URL, type the Engineering Test Management server URL. Type the URL in the
format https://server name:port number/context root where server name
is the Rational Quality Manager server host name that you specified in the hosts file. For
example, type https://RQM01:9443/qm.
Note: If the Rational Quality Manager server is renamed, complete these steps:
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i. If you have an entry for the Rational Quality Manager server in the hosts file, update it
with the new server name.
ii. Update the Server URL field with the new server name.
iii. Configure the adapter again to point to the new URL.
b. In Adapter Name, type a unique name to identify the Engineering Test Management adapter
on this workstation. By default, the adapter uses the name of the computer.
c. To connect the adapter to a project area other than the default Engineering Test
Management project, type the name of the project to connect to.
2. In Authentication type, specify the authentication mode to connect to Engineering Test
Management.
• User name and Password - Specify the user ID and password of the Engineering Test
Management user account.
• Kerberos - Select the kerberos .ini file. The file is automatically created when you set up
Kerberos. Typically, on Windows, the file would be located at c:\windows\krb5.ini. The
file name and the location would change for different operating systems.
• SSL Cert - From v9.1.0.1, specify the location of the SSL certificate keystore and the
keystore password. The expected format of the keystore is p12. It should only contain the
client certificate that the adapter should use when authenticating with Engineering Test
Management.
3. Optional: To connect through a proxy computer, select the Enable Proxy check box and specify the
host name, port number, user name, and password of the proxy computer.
4. To connect by using the Kerberos authentication mode, select the Enable Kerberos check box and
specify the Kerberos configuration file.
5. Click OK to save the configuration.
To connect to Engineering Test Management, you can now start the adapter from the workbench, from
command line, or as a Windows service.
Note: To run Web UI tests for IBM® Rational® Functional Tester from Engineering Test Management,
you must start the adapter either from the workbench or from command line.

Related information
Engineering Test Management integration overview on page46
Starting and stopping the Engineering Test Management adapter in the workbench on
page50
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Starting and stopping the Engineering Test Management adapter from the command line on
page51
Starting and stopping the Engineering Test Management adapter as a Windows service on
page52
Importing test assets into Engineering Test Management on page54

Starting and stopping the Engineering Test Management adapter in the
workbench
You can use the Quality Manager Adapter view to connect, disconnect, and view adapter activities from
the test workbench.
Note: The term test workbench refers to either Rational® Performance Tester, Rational® Service
Tester for SOA Quality, or Rational® Test Workbench.
Before running the Engineering Test Management adapter, you must configure the test workbench and the
adapter.
In GUI mode you can use the Quality Manager Adapter view to start, stop, and view adapter activities. In
GUI mode, when a script is run from Engineering Test Management, you see the test running inside the
test workbench as though the test were run manually in a test workbench.
Push buttons to connect and disconnect to the Engineering Test Management server are located in the
upper-right corner of this view. This view also has a local preferences menu that you can use to control
some behavior of the GUI mode adapter. If you see errors or warnings, use the Error Log view for further
investigation.
Note: Do not use the workbench while the adapter is running. Doing so might interfere with the ability
of the adapter to run test scripts. Stop the adapter before opening the workbench.
1. On the test workbench, click Window > Show View > Quality Manager Adapter to open the Quality
Manager Adapter view.
2. To start the adapter, click Connect to ETM.
3. To stop the adapter, click Disconnect from ETM.
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Related information
Engineering Test Management integration overview on page46
IBM Engineering Test Management overview on page
Configuring the Engineering Test Management adapter on page48
Starting and stopping the Engineering Test Management adapter from the command line on
page51
Starting and stopping the Engineering Test Management adapter as a Windows service on
page52
Importing test assets into Engineering Test Management on page54

Starting and stopping the Engineering Test Management adapter from the
command line
You can use the command line interface to connect, disconnect, and view adapter activities from the test
workbench.
Configure the adapter in the test workbench. See Configuring the Engineering Test Management adapter
on page 48.
Configure the adapter workspace directory in the following manner:
1. Locate the adapter.config file in the product_install_dir \RPT-RST_RQMAdapter
\config\product_install_dir \HOT-PERF_RQMAdapter\config\ directory, where
product_install_dir is the directory where the test workbench is installed, for example, C:\Program
Files\IBM\SDP.
2. Edit the WORKSPACE_DIR variable in the adapter.config file to point to the same test
workspace that you want the adapter to use, for example: .
Note: If the Use resources that are local to a test machine option is set in IBM® Engineering Test
Management, the WORKSPACE_DIR should also be set to the same workspace where your test assets are
located.
When running from the command line, adapter activities are printed to the
product_install_dir\HOT-PERF_RQMAdapter\logs\adapter.log file. To print the current
status of the adapter, navigate to the product_install_dir\RPT-RST_RQMAdapter\bin\
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directory, where product_install_dir is the workbench installation directory, and enter this command:
RQMAdapter.bat STATUS.
Note: Do not use the workbench while the adapter is running. Doing so might interfere with the ability
of the adapter to run test scripts. Stop the adapter before you open the workbench.
1. Open a command-line window, and navigate to the product_install_dir\RPTRST_RQMAdapter\bin\ directory , where product_install_dir is the directory where the test
workbench is installed, for example: C:\Program Files\IBM\SDP.
2. To start the adapter from the command line, run the adapter command:
• In Windows™, type: RQMAdapter.bat START
• In Linux™, type: RQMAdapter.sh START
3. To stop the adapter from the command line, run one of these adapter commands:
• In Windows™, type: RQMAdapter.bat STOP
• In Linux™, type: RQMAdapter.sh STOP

Related information
Engineering Test Management integration overview on page46
IBM Engineering Test Management overview on page
Configuring the Engineering Test Management adapter on page48
Starting and stopping the Engineering Test Management adapter in the workbench on
page50
Starting and stopping the Engineering Test Management adapter as a Windows service on
page52
Importing test assets into Engineering Test Management on page54

Starting and stopping the Engineering Test Management adapter as a
Windows™ service
You can use the Windows™ service to connect, disconnect, and view adapter activities from the test
workbench.
Configure the adapter in the test workbench. See Configuring the Engineering Test Management adapter
on page 48.
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The adapter service for Windows™ requires the computer to have Microsoft™ .NET Framework 3.5.x or
later.
Configure the adapter workspace directory in the following manner:
1. Locate the adapter.config file in the product_install_dir \RPT-RST_RQMAdapter
\config\product_install_dir \HOT-PERF_RQMAdapter\config\ directory, where
product_install_dir is the directory where the test workbench is installed, for example, C:\Program
Files\IBM\SDP.
2. Edit the WORKSPACE_DIR variable in the adapter.config file to point to the same test
workspace that you want the adapter to use, for example: .
Note: If the Use resources that are local to a test machine option is set in IBM® Engineering Test
Management, the WORKSPACE_DIR should also be set to the same workspace where your test assets are
located.
When you install the test workbench, you also install the adapter as a Windows™ service. By default, the
service is set to start manually.

Note:
• When the adapter is started as a service, the Web UI tests of IBM® Rational® Test Workbench
cannot be run from IBM® Engineering Test Management.
• Do not open the test workbench in the same workspace while the adapter is running as a
Windows™ service. Doing so might interfere with the ability of the adapter to run test scripts. Stop
the adapter before you open the workbench in the configured workspace.
1. Open the Windows™ service manager.
2. To start the service, right-click IBM RTW-RPT-RST adapter for RQM and click Start.
The adapter is same for IBM® Rational® Service Tester for SOA Quality, IBM® Rational® Test
Workbench and IBM® Rational® Performance Tester.
3. To stop the service, right-click IBM RTW-RPT-RST adapter for RQM and click Stop.
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Optionally, you can configure the service to start automatically by right-clicking the adapter listing,
selecting Properties, and selecting Automatic as the startup type. With this setting, the adapter can start
automatically when the computer restarts, without requiring a user to log in.
When running the adapter as a service, status is printed to the install_dir\RPT-RST_RQMAdapter
\logs\adapter.loginstall_dir\HOT-PERF_RQMAdapter\logs\adapter.log file. You can
also print the status by navigating to the install_dir\RPT-RST_RQMAdapter\bin\ directory, and
entering this command: RQMAdapter.bat STATUS.

Related information
Engineering Test Management integration overview on page46
IBM Engineering Test Management overview on page
Configuring the Engineering Test Management adapter on page48
Starting and stopping the Engineering Test Management adapter in the workbench on
page50
Starting and stopping the Engineering Test Management adapter from the command line on
page51
Importing test assets into Engineering Test Management on page54

Importing test assets into Engineering Test Management
With the adapter, you can import the performance, service, and functional tests into Engineering Test
Management.
Before importing test assets into Engineering Test Management, the adapter must be running on a
computer where the test assets are located.
1. Log in to Engineering Test Management, and click Construction > Import Test Scripts.
2. In Script Type, select one of the following test scripts:
a. Select Rational® Performance Tester to import a performance test or schedule from
Rational® Performance Tester.
b. Select Service Test to import a service test from Rational® Service Tester for SOA Quality
c. Select Rational® Functional Tester to import a functional test from Rational® Functional
Tester.
d. Select Rational® Test Workbench to import a Web UI test from Rational® Functional Tester
or import a test from Rational® Test Workbench.
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Note: From Rational® Functional Tester, you cannot import AFT suites into Engineering Test
Management because AFT suites are not supported with the Engineering Test Management
integration.
3. Select Use test resources that are local to a test machine, and click Select Adapter.
4. Select the computer on which the adapter is running, and click Next.
5. In Project Path, type the name of the project, and click Go.
You must specify only the project name and not the entire path to the project.
6. Select the test assets that to import, and click Finish.
7. Select the test assets to import again and click Import.
The test scripts are imported to Engineering Test Management.
See the Engineering Test Management Knowledge Center for more information about importing test
scripts.

Related information
Engineering Test Management integration overview on page46
IBM Engineering Test Management overview on page
Configuring the Engineering Test Management adapter on page48
Starting and stopping the Engineering Test Management adapter in the workbench on
page50
Starting and stopping the Engineering Test Management adapter from the command line on
page51
Starting and stopping the Engineering Test Management adapter as a Windows service on
page52
Testing shared assets with Rational Quality Manager on page55

Testing shared assets with Rational® Quality Manager
You can make test projects and assets shareable in Rational® Quality Manager. By sharing assets,
any computer with your product, that is connected to Rational® Quality Manager can execute a test or
schedule.
When you are working with tests or schedules from a remote shared location, Rational® Performance
Tester, Rational® Service Tester for SOA Quality, or Rational® Test Workbench uses a local workspace
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for the Rational® Quality Manager adapter. This adapter workspace is different from normal workspaces
because the test assets are stored remotely. This means that every asset that is related to the test
or schedule is downloaded from the shared location into the local workspace before execution. The
following limitations apply:
• Assets in the adapter workspace might be deleted or overwritten with newer versions when
updates are made to the shared location.
• If you change the shared location in the adapter workspace, the entire project is removed from the
adapter workspace.
• Test results are stored in a different project, called RQM_Results, and are never deleted. The
Rational® Quality Manager test result page links to the correct location.
Note: Do not edit test assets in the adapter workspace because you might lose your work. Use these
assets only for running tests and schedules.
If you are using source control and want to include only the minimum required assets, then include the
following files:
• All *.testsuite tests and schedule files
• The /src directory if you use custom code
• All *.dp dataset files
• All *.location location files
• All digital certificates
• All WSDL and SOA security files.
All other assets, such as test results, are not required.
Custom code Java™ classes in the shared assets cannot use libraries that are outside the workspace. If
your custom code must use such a library, then copy the library into the project, and update the classpath
to use the local copy.
To share tests and schedules in Rational® Quality Manager:
1. Create a shared directory on the computer that hosts the UNC file system that contains the test
projects to share.
For example, create this directory: C:\MyRemoteWorkspace.
2. Copy the test projects to share into the shared directory.
If a project is stored in source control software, then copy it from there.
3. Check that the Rational® Quality Manager server can access the shared directory by using UNC
paths.
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For example, the \\MyServer\RPTRemoteAssets\ path must be mapped to the C:
\MyRemoteWorkspace directory.
4. In Rational® Quality Manager, specify the directory that contains the actual test projects that are
located in the shared directory.
5. Verify that you have correctly specified the UNC shared directory by browsing for the shared
resource. Ensure that the first dialog box contains the projects at the first level.
You must not have intermediate directories between the UNC shared directory and the project
directory.
See the Rational® Quality Manager Information Center for more information about setting up shared
resource locations and importing shared scripts.

Related information
Engineering Test Management integration overview on page46
IBM Engineering Test Management overview on page
Configuring the Engineering Test Management adapter on page48
Importing test assets into Engineering Test Management on page54

Testing with Jenkins
You can use the Rational® Performance Tester Jenkins plugin for performance testing to run tests on a
Jenkins server by using a Jenkins build step.

Introduction
To automate testing with Jenkins, you must configure Jenkins primary server and Jenkins secondary
server. This configuration allows a single Jenkins installation on the Jenkins primary server to host
multiple Jenkins secondary server for building and running tests. You must install the latest version of
the Rational® Performance Tester Jenkins plugin on the Jenkins primary server, and install the products
themselves on the Jenkins secondary server, where you create the tests. For detailed information about
the Jenkins primary and secondary server relationship, see the Distributed Builds section on the Jenkins
site.
Note: You can download the latest version of the Rational® Performance Tester Jenkins plugin from
Test Workbench Resource Community. You can then install the plugin on the Jenkins server. After you
create the tests in Rational® Performance Tester, you can run the tests on the Jenkins server by using
this plugin.If you have earlier version of the Rational® Performance Tester Jenkins plugin, you must
uninstall it before installing the latest version of the plugin on the Jenkins server.
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Before you begin
You must have completed the following tasks:
• Installed IBM® Installation Manager, which is required for installing the products.
• Installed the products themselves.
• Verified that you have a Jenkins primary server where Jenkins and the Rational® Performance
Tester Jenkins plugin is installed.
• Verified that you have a Jenkins secondary server where the products are installed.
• Verified that you have a test residing within an Eclipse workspace on the Jenkins secondary server
where the products are installed.
Note:
To run performance test on Mac OS, you must add an environment variable that points to the installation
directory of the product, for example, export

TEST_WORKBENCH_HOME=/opt/IBM/SDP.

For Windows™ and

Linux®, this environment variable is set when you install the product.

Installing the Rational® Performance Tester Jenkins plugin on the Jenkins master
computer
1. Download the latest version of the Rational® Performance Tester Jenkins plugin for the
appropriate test product from Test Workbench Resource Community on to the computer where the
test product is installed.
2. From the Jenkins dashboard, perform the following tasks:
a. Click Manage Jenkins > Manage Plugins.
b. Click Advanced.
c. From the Upload Plugin section, click Choose File to locate and Open the Rational®
Performance Tester Jenkins plugin.
d. Click Upload.
The Rational® Performance Tester Jenkins plugin is displayed in the Installed tab.
3. To allow Random TCP Ports for Java™ Network Launch Protocol (JNLP) agents, perform the
following steps:
a. Click Manage Jenkins > Configure Global Security.
b. In the Agents section, select Random.
c. Click Save to save and apply the changes.
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Job Configuration
1. Create a new Jenkins free-style software project. For more information to create a free-style
Jenkins project, see Building a software project in Jenkins.
2. Optionally, set an environment variable in Manage Jenkins > Configure System > Global properties
from the Jenkins dashboard.
Select the Environment variables check box if it is not selected. Add the variable and save the
details.
3. From the Jenkins dashboard, perform the following tasks:
a. Open the Jenkins free-style software project, and then click Configure.
b. Click Build > Add build step.
c. Click Run IBM® Rational® Performance Tester test.
4. Provide the details about the test run as shown. The following table explains each field.
Field

Description

Name

Required. The name of the test.

Work

Required. The complete path to the Eclipse workspace.

space
Project

Required. The path, including the file name of the project relative to the work
space.

Test

Required. The path, including the file name of the test to run related to the project.

Suite
Name
IMShared Optional. The complete path to IBMIMShared location,if it is not the default loca
Location tion.
Var File

Optional. The complete path to the XML file that contains the variable name and
value pairs.

Config

Optional. The complete path to a file that contains the parameters for a test or

File

schedule run.

Results

Optional. The name of the results file. The default result file is the test or schedule

File

name with a time stamp appended. The results file is stored in the Results direc
tory. If you are running multiple tests, do not provide a name for the results file.
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Field
Over

Description
Optional. Determines whether a result file with the same name is overwritten. The

write Re default value is true, which means the result file can be overwritten.
sults File
Quiet

Optional. Turns off any message output from the launcher and returns to the com
mand shell when the run or the attempt is complete.

Number

Optional. For a schedule, the default value is the number of users specified in the

of Virtual schedule editor. For a test, the default value is one user. Overrides the default
Users

number of users, if required.

VM Args Optional. Java™ virtual machine arguments to pass in.
Dataset

Optional. For a test or schedule, the default value is the dataset specified in the

Override

test editor or schedule editor. Overrides the default dataset value to run if re
quired.
Note:
You must use the Dataset Override option to replace the dataset values during
a test or schedule run. You must ensure that both original and new datasets are
in the same workspace and have the same column names. You must also include
the path to the dataset.
For example,
/project_name/ds_path/ds_filename.csv:/project_name/ds_path/new_ds_filename.csv.

You can swap multiple datasets that are saved in a different project by adding
multiple paths to the dataset separated by a semicolon (;).
For example,
/project_name1/ds_path/ds_filename.csv:/project_name1/ds_path/new_ds_filename.csv;/project_name2/ds_path/ds_filename.csv:/project_name2/ds_path/new_ds_filename.csv

Exported Optional. The complete path to a directory to store exported statistical report da
Statisti
cal Re
port Da
ta File
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Field

Description

Exported Optional. You can use this field to specify a format for the report that you want to
Statisti

export. You must use at least one of the following formats for this field:

cal Re

• simple.csv

port For

• full.csv

mat

• simple.json
• full.json
• csv
• json
For example, Exported Statistical Report Data File <local_dir_path> Exported Sta
tistical Report Format json.
You can add multiple formats for the report separated by a comma.
If you want to export both the simple and full reports in a json or csv format, you
can specify json or csv as the format in the field.
The reports are saved to the location specified in the Exported Statistical Report
Data File field.
You must use the Exported Statistical Report Format field with the Exported Sta
tistical Report Data File field.

Custom

Optional. A comma-separated list of absolute paths to custom report format files

Report

(.view files) to use when exporting statistical report data with the Export Statisti

Format

cal Report Data File option.

Files
Export

Optional. The complete path to a directory to export web analytic results. Analyze

ed Sta

the results on a web browser without using the test workbench. If you run multiple

tistical

tests, do not provide a value in this field. The web analytic results will be exported

Report in to Jenkins workspace.
html
Re

Optional. For a schedule (Rate schedule or VU schedule), use Resource Monitor

source

ing Labels Override to perform any of the following actions:

Moni
toring
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Field

Description

Labels

• To enable the Resource Monitoring from Service option for a performance

Override

schedule if the Resource Monitoring from Service option is not enabled
from the schedule editor in Rational® Performance Tester.
• To ignore Resource Monitoring sources that were set in the performance
schedule and to change for a label matching mode.
• To replace an existing set of Resource Monitoring labels that were set
in the performance schedule and run the schedule with a new set of Re
source Monitoring labels.
Note: You can add multiple Resource Monitoring labels separated by a comma.
Important: You must add the Resource Monitoring labels to the Resource
Monitoring sources on the Resource Monitoring page in your IBM® Rational®
Test Automation Server project.

User

Optional. Add text within the double quotation mark to display it in the User Com

Com

ments row of the report.

ments
If you do not supply a value for Exported Statistical Report Data File, these logs will be saved
in Jenkins workspace/temp directory.
5. Click Save.
6. Optionally, to run multiple tests under the same job, click Add build step again, and provide details
for the next test.

Environment variable configuration
After you set the environment variable in Manage Jenkins > Configure System > Global properties
on the Jenkins server, you can enter the variable name by using any of the following methods for the
corresponding text fields in the Run IBM® Rational® Performance Tester test step:
• Use the dollar sign ($) followed by the variable name.
For example, $workspace
• Use the dollar sign ($) followed by the variable name between braces.
For example, ${workspace}
You can then run the Jenkins build by using environment variables in the Run IBM® Rational®
Performance Tester test step. The environment variable that you added to your test is substituted with
the actual value associated with the variable that you set in Manage Jenkins > Configure System > Global
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properties for the job. The Rational® Performance Tester Jenkins plugin uses the actual value while
running the job.
For example,
If you set the environment variable named workspace with the value C:\Users\IBM\workspace1 in
Manage Jenkins > Configure System > Global properties, then you can use $workspace or ${workspace} as
input to the corresponding text field of your choice for the Run IBM® Rational® Performance Tester test
step in the Jenkins build step. When you run the build, $workspace or ${workspace} is substituted with its
corresponding value C:\Users\IBM\workspace1.

Jenkins primary server and secondary server configuration
The Jenkins primary and secondary server configurations are supported by Rational® Performance Tester
Jenkins plugin . Refer to Distributed builds for more information.
While creating the job configuration, in addition to the preceding steps, you must select the Restrict where
this project can be run check box and provide the name of the slave node in the Label Expression field.
This is the location where the products are installed and where tests can be run.

Running tests
After you save the project, you must open the project, and then click Build Now. This action starts the test
run on the slave computer. You must specify the relative path from the project to the test including the
file name of the test. To run multiple tests from different projects, you must add new build step for each
project.
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Building result and logs
1. After the build completes, click the build number and open the console for the project. Locate the
Test Result

to check the test execution status.

Note: If you add multiple build steps to run multiple tests, multiple Test

Result

instances are

displayed.
In Rational® Performance Tester, if the IBM® Rational® Test Automation Server URL is configured
in Window > Preferences > Test > Rational® Test Automation Server and Publish result after
execution is set as Always in Window > Preferences > Test > Rational® Test Automation Server
> Results, then the Reports information section on the Console page displays the names of the
report along with its corresponding URLs. The report URLs are the Rational® Test Automation
Server URLs where the reports are stored. You can access the report URLs to view the test
execution information at any point of time.
2. For product logs, log in to the slave computer and search in the Jenkins slave workspace/temp
directory.

Testing with Ant
You can use ant to run performance and compound tests from the command line. Starting from V2.0.0
of the ant plugin, you can run multiple tests simultaneously. V5.0 of the ant plugin is supported in IBM®
Rational® Performance Tester V10.0.2 of the testing products.
You must have completed the following tasks:
• Installed IBM® Installation Manager.
Note: If you are running an earlier version of the ant plugin, you must shut down the product
and IBM® Installation Manager before starting the test execution. From V2.0 of the ant plugin,
shutting down the IBM® Installation Manager is no longer necessary before starting the test
execution.
• Installed the products themselves.
• Verified that you have a test residing within an Eclipse workspace on the computer where the
products are installed.
• Added ant to the PATH environment variable.
Note:
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To run performance tests on Mac OS, you must add an environment variable that points to the installation
directory of the product, for example, export

TEST_WORKBENCH_HOME=/opt/IBM/SDP.

For Windows™ and

Linux®, this environment variable is set when you install the product.
1. Download the ant plugin for the test products from Test Workbench Resource Community on to the
computer where the test product is installed.
2. Extract the following files from the downloaded plugin:
• RPT-Ant-5.0.jar
• ExecutePerformanceTest.xml
• README.txt
3. Open the ExecutePerformanceTest.xml file and provide parameter values, as
shown in the following performance test example: <pt

name="test1" workspace="C:

\workspace" projectname="TestProject" suite="Tests/test1.testsuite" results="Results/
test1_on_anttask" />

• To run multiple tests, add additional <pt> tasks and provide details for each test.
The following table explains each field.
Field

Description

- name

Required. The name of the test for the particular test product.

- work

Required. The complete path to the Eclipse workspace.

space
- project Required. The path, including the file name of the project relative to the work
name
- suite

- varfile

space.
Required. The path, including the file name of the test to run relative to the project.
A test can be a performance schedule or a compound test.
Optional. The complete path to the XML file that contains the variable name and
value pairs.

- con

Optional. The complete path to a file that contains the parameters for a test or

figfile

schedule run.

- results

- over
write

Optional. The name of the results file. The default result file is the test or schedule
name with a time stamp appended.
Optional. Determines whether a result file with the same name is overwritten. The
default value is false, which means the result file cannot be overwritten and a
new result file is created.

65

Administrator Guide

Field
- quiet

Description
Optional. Turns off any message output from the launcher and returns to the com
mand shell when the run or the attempt is complete.

- vmargs Optional. Java™ virtual machine arguments to pass in.
Optional. For a test or schedule, the default value is the dataset specified in the
test editor or schedule editor. Overrides the default dataset value to run if re
quired.
Note: You must use the swapdatasets option to replace dataset values
during a test or schedule run. You must ensure that both original and new
- swap

datasets are in the same workspace and have the same column names. You

datasets must also include the path to the dataset. For example: /project_name/ds_path/ds_filename.csv:/project_name/ds_path/new_ds_filename.csv. You can swap multiple datasets that are saved in a different project
by adding multiple paths to the dataset separated by a semicolon. For example:
/project_name1/ds_path/ds_filename.csv:/project_name1/ds_path/new_ds_filename.csv;/project_name2/ds_path/ds_filename.csv:/project_name2/ds_path/new_ds_filename.csv
Optional. For a schedule (Rate schedule or VU schedule), use -overridermlabels
to perform any of the following actions:
• To enable the Resource Monitoring from Service option for a performance
schedule if the Resource Monitoring from Service option is not enabled
from the schedule editor in Rational® Performance Tester.
• To ignore Resource Monitoring sources that were set in the performance
-overri
dermla
bels

schedule and to change for a label matching mode.
• To replace an existing set of Resource Monitoring labels that were set
in the performance schedule and run the schedule with a new set of Re
source Monitoring labels.
Note: You can add multiple Resource Monitoring labels separated by a comma.
Important: You must add the Resource Monitoring labels to the Resource
Monitoring sources on the Resource Monitoring page in your IBM® Rational®
Test Automation Server project.

- export Optional. The complete path to a directory that can be used to store exported sta
stats
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Field

Description

- export Optional. A comma-separated list of absolute paths to custom report format files
statre

(.view files) to use when exporting statistical report data with the -exportstats op

portlist

tion.

- export Optional. The complete path to a directory that can be used to export web analytic
stat

results. The results are exported in the specified directory. Analyze the results on

shtml

a web browser without using the test workbench.

- user

Optional. Add text within the double quotation mark to display it in the User Com

com

ments row of the report.

ments
Optional. For a schedule, the default value is the number of users specified in the
- users

schedule editor. For a test, the default value is one user. Overrides the default
number of users, if required.

-

Optional. The complete path to IBMIMShared location, if it is not at the default lo

imshared cation.
loc
4. Open a command prompt and navigate to the download directory.
5. Type ant -f ExecutePerformanceTest.xml to start test execution.
When Ant execution completes, a test result is displayed. Ant execution output is logged into the
logfile.txt file, and a test log is created in a temp directory under RPT-Ant-5.0 from where
the ant command is executed.
In Rational® Performance Tester, if the IBM® Rational® Test Automation Server URL is configured
in Window > Preferences > Test > Rational® Test Automation Server and Publish result after
execution is set as Always in Window > Preferences > Test > Rational® Test Automation Server
> Results, then the Reports information section on the Log file displays the names of the report
along with its corresponding URLs. The report URLs are the Rational® Test Automation Server
URLs where the reports are stored. You can access the report URLs to view the test execution
information at any point of time.

Testing with Maven
Starting from V9.2.0, you can use the Maven plug-in that is provided with the testing product to run tests
as part of your Maven build. Apache Maven is a software build tool based on the concept of a project
object model (POM).
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Before you begin
• You must have installed the testing product from V9.2.0 and set an environment variable that
points to the installation location.
For Mac OS, add an environment variable that points to the installation directory of the product:
export TEST_WORKBENCH_HOME=/opt/IBM/SDP
For Windows™ and Linux®, this environment variable is set when you install the product.
• You must have installed Maven from V3.2.0 and set up an environment variable that points to the
M2_HOME installation directory.

Introduction
To automate testing with Maven, you must configure a pom.xml file and launch your tests from the
command line using Maven command. You can either use your own pom.file, or one that is delivered with
the product.
Three files are delivered with the product installation in the <product install location>\SDP
\maven2\ folder:
• pomCustomSurefireSample.xml for Windows, Linux and macOS.
• pomMojoExecPluginSample_Linux.xml for Linux and MacOS.
• pomMojoExecPluginSample_Windows.xml for Windows.
The files contain all types of dependencies as well as arguments required to execute the test scripts.
There are two methods to run tests with Maven.

Method 1
With this method, you can run one or several tests. If you use your own pom.xml file, edit
it with the following lines and indicate which test(s) must be executed, otherwise, use the
pomCustomSurefireSample.xml file as follows:
• Copy the pomCustomSurefireSample.xml to a directory.
• Edit the file and update the lines, enter the name and location of the test(s) that must be run. If the
product is installed on a different drive or a different location, or if location has been changed, enter
the correct path to the IBMIMShared plug-in folder. For aftsuite attribute, you can input aft xml file
as the parameter value.
<!--test suite="testSources/Test1.testsuite"/-->
<!--test suite="Test2.testsuite"/-->

68

Chapter 1. Administrator Guide

<test suite="C:/Runtimes/runtime-RptMvn/AA/testSources/Test2.testsuite" plugins="C:/Program
Files/IBM/IBMIMShared/plugins"/>
<!--test

schedule="Schedule.testsuite" project="AA" workspace="C:/Runtimes/runtime-RptMvn"

plugins="C:/Program Files/IBM/IBMIMShared/plugins"/-->
<!--test

suite="Test2.testsuite" project="AA" workspace="C:/Runtimes/runtime-RptMvn"/-->

<!--test aftsuite="Test1.xml" project="AA" workspace="C:/Runtimes/runtime-RptMvn" plugins="C:/Program
Files/IBM/IBMIMShared/plugins"/-->

• Run Maven to update the pom file version command and use the plug-in version currently available
on delivered repositories.
mvn versions:update-properties -Dincludes=com.hcl.products.test.it -f pomCustomSurefireSample.xml

• Run the test(s).
mvn clean verify -f pomCustomSurefireSample.xml

Fail safe reports are generated in the target directory, especially in target/failsafe-reports/
<ProjectName>/<TestName>_<timestamp>.txt that will contain the screen capture of the
execution.
In Rational® Performance Tester, if the IBM® Rational® Test Automation Server URL is configured in
Window > Preferences > Test > Rational® Test Automation Server and Publish result after execution
is set as Always in Window > Preferences > Test > Rational® Test Automation Server > Results, then
the Reports information section on the Console page displays the names of the report along with its
corresponding URLs. The report URLs are the Rational® Test Automation Server URLs where the reports
are stored. You can access the report URLs to view the test execution information at any point of time.

Method 2
With this method, no Maven report is generated. If you use your own pom.xml file,
copy the following lines and provide your parameter values. Otherwise, you can use the
pomMojoExecPluginSample_Linux.xml or pomMojoExecPluginSample_Windows.xml sample
file. Example with the pomMojoExecPluginSample_Windows.xml sample file:
• Copy pomMojoExecPluginSample_Windows.xml to a directory.
• Edit the file and update the arguments to reflect which test to execute. If the product is installed on
a different drive or a different location, or if IBMIMShared location has been changed, update the
two last lines with the path to the IBMIMShared plug-in folder.
<argument>/C</argument>
<argument>${pt-plugin-cmdline}</argument>
<argument>-workspace</argument>
<argument>C:\Runtimes\runtime-RptMvn</argument>
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<argument>-project</argument>
<argument>AA</argument>
<argument>-suite</argument>
<argument>Test1.testsuite</argument>
<argument>-plugins</argument>
<argument>C:/Program Files/IBM/IBMIMShared/plugins</argument>

• In the argument tags, instead of the -suite option, you can use the -aftsuite option and
input the aft xml file as the parameter value in the subsequent argument tag to run the
AFT test. For example, in the preceding template, <argument>-suite</argument>
<argument>Test1.testsuite</argument> can be replaced with <argument>aftsuite</argument> <argument>aftfile.xml</argument>.
• Run the test.
For Windows:
mvn clean verify -f pomMojoExecPluginSample_Windows.xml

For Linux or MacOS:
mvn clean verify -f pomMojoExecPluginSample_Linux.xml

Related information
https://maven.apache.org/index.html

Testing with Rational® Integration Tester
Starting from V9.1.1, you can use Rational® Integration Tester extension to execute Integration tests. In
Rational® Performance Tester, you can either import the projects from Rational® Integration Tester or
manage them from Rational® Performance Tester by establishing the connection between the products.
In Rational® Performance Tester , you can create a schedule or compound test to run the tests by using
the Agents.

Before you begin
To be able to work with Integration tests, you must install Rational® Performance Tester Extension for
Rational® Integration Tester.
You also need a Rational® Performance Tester agent or a Rational® Integration Tester agent to execute
the tests remotely. When installing Rational® Integration Tester agent, it is recommended to choose This
Agent will only run probes option.
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Moreover, if you update Integration tests in Rational® Performance Tester and want to apply the updates
back to Rational® Integration Tester, you must install Rational® Integration Tester and define the path to
its installation directory to set the connection.
Following are the use cases to work with Integration tests in the Rational® Performance Tester :
• Both the products are installed and you connect to the Integration project, or you open the
Integration resource directly from Test Navigator view and you work directly with the sources files.
• Rational® Integration Tester is not installed and you import the projects in the Rational®
Performance Tester workspace.
Note: The imported tests must be edited in Rational® Integration Tester. Similarly, the
schedules and compounds tests must be edited in Rational® Performance Tester .
• To execute Performance tests with imported tests on page 77, the Rational® Integration Tester
agent must be installed along with the Rational® Performance Tester agent. The environment
variable INTEGRATION_TESTER_AGENT_HOME must be defined on each location where the
agent is installed, and must point to the root directory of the Rational® Integration Tester agent
installation.

Connecting to an existing Integration project
When you connect both the products any change or delete action made in one product workspace is
reflected on the other product workspace, if both the products are installed on your machine.
Warning: If you delete a project from the Test Navigator, be sure that the option Delete project
contents on disk is not selected in the Delete Resources dialog, otherwise the project would be deleted in
Rational® Integration Tester if it is connected.
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• In Rational® Performance Tester , right-click on the Test Navigator, select New > Other > Rational®
Integration Tester > Connect to an Rational® Integration Tester Project and click Next.

• In the wizard page, click Browse and select the root folder that contains the project.
If the path contains a project, its name should automatically appear in Project Name and the Finish
button should be enabled.
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• In When project is connected, you have to perform one of the following actions:
◦ Click Do nothing to only import the project.
◦ Click Open Create Rate Schedule wizard to select the test, create a Rate Schedule, and add
the test to it.
◦ Click Open Create VU Schedule wizard to select the test, create a VU Schedule, and add the
test to it.
◦ Click Open Create Compound Test Wizard to select the test, create a Compound test, and
add the test to the Compound test. For more details, see Creating a compound test on page
and Adding tests into a compound test on page

.

For example: select the Open Create VU Schedule wizard action and click Next.
The Create Rate Schedule for Integration Tester or Create VU Schedule for Rational®
Integration Tester wizard displays the list of tests contained in your project.
◦ Select one or more tests and click Next.
◦ In Schedule File Name and Location wizard, select a schedule in an existing project, or
create it from this window. You just need to enter a name for the new schedule and click
Finish. The procedure is the same for the compound test.
◦ The Test Navigator displays the projects:
▪ The Rational® Integration Tester project you are connected to, or that you imported,
with the tests.
▪ The Rational® Performance Tester project containing the schedule or compound
test. If Rational® Integration Tester is installed, Connected is indicated near the name
of the project in the Test Navigator. The Schedule or compound test automatically
opens in the dedicated editor.
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Setting Rational® Integration Tester preferences
To be able to open an Rational® Integration Tester project from Rational® Performance Tester Test
Navigator, you need to have both the products installed on the same computer, and you must set the path
to the execution file in the Preferences.
• In Rational® Performance Tester , click Window > Preferences > Test > RIT Integration.
• Click Browse and set the installation path to Rational® Integration Tester execution file. On
Windows, the default location would be C:\Program Files\IBM\IntegrationTester.exe.
• Click Apply and OK.

Opening Rational® Integration Tester resources from the Test Navigator
• Once the preferences are set, you can open an Rational® Integration Tester project.
• In the Test Navigator, open the project root node and children nodes, and at any level, right-click
and select Open in Rational® Integration Tester Workbench.

If Rational® Integration Tester is automatically detected, the workspace opens for the selected
resources.
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If Rational® Integration Tester is not detected, a dialog opens on a Preference page where you
need to verify the path to the execution file.
•

Warning: Rational® Integration Tester cannot open more than one project at a time. If you
have another project open, you will get an error. In that case, close Rational® Integration Tester and
try to open the project again.

Importing Rational® Integration Tester project
If both the products are not installed on the same machine, you can import an Rational® Integration
Tester project in your workspace. Another reason for the import is when you have Rational® Integration
Tester installed but you do not want to connect to the Rational® Integration Tester project. In that case,
the project is duplicated, any updates in one product workspace will not be reflected in the other product's
workspace.
• To import an Rational® Integration Tester project:
• Right-click on the Test Navigator, choose Import and select Existing project into workspace.
• Choose Select root directory or Select archive file; select a project to import and click Finish.
The selected project appears in the Test Navigator and the compound test or schedule editor
automatically opens.

Modifying Rational® Integration Tester environments in Rational® Performance Tester
In the schedule or compound test, you can select Rational® Integration Tester tests and change the
environment of each test. The environments are set in Rational® Integration Tester, you can only change
the selection from the edited schedule or compound test.
• Open the schedule or compound editor and select a test.
• In the Rational® Integration Tester details, you can browse and change the properties of the
selected test. The Test path, the Environments and Decription are automatically updated
accordingly.
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• To select another environment for the Integration Tester test, use the dropdown menu.
Alternatively, you can change the environment selection for a test for a collection of tests:
• Right-click on the tree at any level under a node in the schedule or compound
test and select Replace Rational® Integration Tester Environments.

• In the Set Invocation Tester Environments wizard, the first page displays the list of projects that
use the selected environment and the number of tests from project that use this environment in the
schedule or compound test.
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• Select another used environment in the dropdown list. Click Finish. The new choice applies to the
selected node and its children.
Next step is to create a compound test or schedule in Rational® Performance Tester to run the
Integration tests on page 77, see Creating a VU Schedule on page
on page

or Creating a compound test

.

You can add a dataset mapper in the compound test or schedule for tests that are using multiple tags.
See Adding Dataset Mapper on page

to map tags in the Rational® Integration Tester tests with the

variable values of Rational® Performance Tester .

Running Rational® Integration Tester tests
You can use IBM® Rational® Performance Tester Extension for IBM® Rational® Integration Tester to run
IBM® Rational® Integration Tester tests.
You can install both the products on the same machine, establish the connection, and run Rational®
Integration Tester tests. See Testing with Rational® Integration Tester on page 70.
You also have the option to just import the projects to Rational® Performance Tester Rational®
Integration Tester, add the tests to a schedule or compound test to run them. You can either use
Rational® Performance Tester Agent or Rational® Integration Tester Agent to generate the load. You need
a compound test or schedule that contains the Rational® Integration Tester tests.

Setting environment variable
To run the tests with Rational® Integration Tester Agent, set the environment variable
INTEGRATION_TESTER_AGENT_HOME and point it to the Rational® Integration Tester Agent
installation directory.
On Linux, set:
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INTEGRATION_TESTER_AGENT_HOME=/opt/IBM/RIT-Agent
export INTEGRATION_TESTER_AGENT_HOME
echo $INTEGRATION_TESTER_AGENT_HOME

If the variable is not set, you will get a test log with error message when the compound or schedule test is
run.

Running the compound test or schedule
• Click Run Compound Test or Run VU Schedule or Run Rate Schedule.
Note: When you execute the integration tests as part of compound tests, the integration test
log is generated and it is available in the Extended Properties section.

RIT Performance Report
The report contains the following pages.
OVERALL
The Overall page provides this information:
• A progress indicator that shows the state of the run.
• A bar chart on the left shows the overall percentage of passed sequences for the
entire run. A sequence corresponds to a test run.
• A bar chart on the right shows the overall percentage of passed timed sections,
which are corresponding to individual sections within the steps of the tests.
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SUMMARY
This page displays information about the run:
• The number of users that are active and the number of users that have completed
testing. This number is updated during the run.
• The elapsed time (run duration)
• The status of the run.
• The Performance Requirements: validates the performance requirements that you set
in a schedule.
The summary page also summarizes the data about the sequence run and timed sections:
Total number of sequences that were started and the total number that have been
completed, or failed, with a minimum and maximum rate.
SEQUENCE THROUGHPUT SUMMARY
This page shows a bar chart of average throughput in seconds for each sequence.
It provides times section throughput for each sequence. You can use the filters to have
displayed results for one sequence only.
And if you add filters, you can see the timed sections throughput for each sequence.
SEQUENCE THROUGHPUT
This page shows the average throughput for all combined sequences during the last
recorded interval over the time period. Click on one of the Total rate boxed to have one
graph displayed at a time or click Select All to see all rates on the same graph.
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The User Load graph shows active users compared to users that have completed testing.
The table after the graph lists the number of active users, the number of users that have
completed testing, and the total user count for the entire run.

SEQUENCE PERFORMANCE
The chart displays the response time of the sequences as the test progresses. You can
apply a filter to see the timed sections of all sequences or the timed sections of a particular
sequence.
The table under the chart shows the average duration for each section of a sequence, the
standard deviation of the average response time, the passed rate.
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Integrating and running performance test scripts in Micro Focus ALM
To obtain test result details, you must integrate and run performance test scripts in Micro Focus
Application Lifecycle Management (ALM) by using a readily available template available in IBM®
Rational® Performance Tester installation directory.
The performance test template is available in the installation directory of Rational® Performance Tester.
You must copy the contents of the template to a new VAPI-XP VBScript test script in Micro Focus ALM,
add your test script details into the VAPI-XP VBScript test script, and then run the test script.
Note: You can use Micro Focus ALM client only on Microsoft™ Internet Explorer. For more
information, see Micro Focus ALM system requirements.
1. Navigate to the directory IBM\SDP\alm in Rational® Performance Tester installation directory.
You can use PT_ALM_Windows.txt file for performance test scripts.
2. Copy the contents of the template.
3. Log in to the Micro Focus ALM portal, if you are not already logged in.
The Micro Focus ALM dashboard is displayed.
4. From Micro Focus ALM, create an new integration test by performing the following actions:
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a. Expand Testing from the left pane and then click Test Plan.
b. Expand Integration.
c. Right-click Integration and click New Test to create a new test.
d. Enter a test name in the Test Name field.
e. Select VAPI-XP-TEST as test type from the Type drop-down list.
f. Click OK.
The VAPI-XP Wizard is displayed.
g. Select a test script language by performing the following steps:
i. Select VBScript from the Script Language drop-down list.
ii. Enter a script name (for example, script) in the Script Name field.
iii. Click Next and select a test type if required.
Note: The COM/DCOM Server Test test type is already selected as a test type.
iv. Click Finish.
The test is created.
5. Click the Test Script tab.
6. Paste the content of the template that you copied in step 2 on page 81 to the test script.
7. Enter the test details in the VAPI-XP Vbscript test script by referring to the following table:
Para

Description

meter
Work

Required. The complete path to the Eclipse workspace.

space
Project

Required. The path, including the file name of the project relative to the work
space.

Testsuit Required. The path, including the file name of the test to run relative to the
eName

project.

IMShared Optional. The complete path to IBMIMShared location.
Location
Varfile

Configfile
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Para

Description

meter
Results
File
Over
writeRe

Optional. The name of the result file. The default result file is the test or schedule
name with a time stamp appended.
Optional. Determines whether a result file with the same name is overwritten. The
default value is true, which means the result file can be overwritten.

sultsFile
Quiet

Optional. Turns off any message output from the launcher and returns to the
command shell when the run or the attempt is complete.
Optional. For a schedule, the default value is the number of users specified in the

Users

schedule editor. For a test, the default value is one user. Overrides the default
number of users, if required.

VMArgs

Optional. You can use this parameter to pass Java™ virtual machine arguments.
Optional. For a test or schedule, the default value is the dataset specified in the
test editor or schedule editor. Overrides the default dataset value to run if re
quired.
Note:
You must use the Dataset Override option to replace the dataset values during a
test or schedule run. You must ensure that both original and new datasets are in
the same workspace and have the same column names. You must also include
the path to the dataset.

Dataset
Override

For example,
/project_name/ds_path/ds_filename.csv:/project_name/ds_path/new_ds_filename.csv.

You can swap multiple datasets that are saved in a different project by adding
multiple paths to the dataset separated by a semicolon (;).
For example,
/project_name1/ds_path/ds_filename.csv:/project_name1/ds_path/new_ds_filename.csv;/project_name2/ds_path/ds_filename.csv:/project_name2/ds_path/new_ds_filename.csv

Re
source

Optional. For a schedule (Rate schedule or VU schedule), use ResourceMonitor
ingLabelsOverride to perform any of the following actions:
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Para

Description

meter

• To enable the Resource Monitoring from Service option for a perfor
mance schedule if the Resource Monitoring from Service option is not en
abled from the schedule editor in Rational® Performance Tester.
• To ignore Resource Monitoring sources that were set in the performance
schedule and to change for a label matching mode.
• To replace an existing set of Resource Monitoring labels that were set

Moni
toring

in the performance schedule and run the schedule with a new set of Re

Labels

source Monitoring labels.

Override

Note: You can add multiple Resource Monitoring labels separated by a comma.

Important: You must add the Resource Monitoring labels to the Resource
Monitoring sources on the Resource Monitoring page in your IBM® Rational®
Test Automation Server project.
ExportS

Optional. The complete path to a directory that you can use to store exported sta

tatsFile

tistical report data.

Export

Optional. A comma-separated list of absolute paths to custom report format files

StatRe

(.view files) that you can use to export statistical report data with ExportStatsFile.

portlist
ExportS
tatsHtml

Optional. The complete path to a directory that you can use to export web analyt
ic results. The results are exported to the specified directory. You can analyze the
results on a web browser without using the test workbench.

UserCom Optional. You can add text within the double quotation mark to display it in the
ments

User Comments row of the report.

8. Run the VAPI-XP Vbscript test script.
You have integrated and run performance test scripts in Micro Focus ALM.
The test result details are displayed in the Output window of Micro Focus ALM.
In Rational® Performance Tester, if the IBM® Rational® Test Automation Server URL is configured in
Window > Preferences > Test > Rational® Test Automation Server and Publish result after execution
is set as Always in Window > Preferences > Test > Rational® Test Automation Server > Results, then
the Reports information section on the Output window displays the names of the report along with its
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corresponding URLs. The report URLs are the Rational® Test Automation Server URLs where the reports
are stored. You can access the report URLs to view the test execution information at any point of time.

Integration with Azure DevOps
When you use Azure DevOps for continuous integration and continuous deployment of your application,
you can create tests for your application in IBM® Rational® Performance Tester and run those tests in
Azure DevOps pipelines. You can integrate Azure DevOps with Rational® Performance Tester by using the
IBM Rational Test Workbench extension that is available in the Visual Studio Marketplace portal.

Prerequisites
Before you integrate Azure DevOps with Rational® Performance Tester, you must have completed certain
tasks. See Prerequisites for Azure DevOps Integration on page 85.

Overview
You can use the IBM Rational Test Workbench extension that enables you to select any type of test
created in Rational® Performance Tester that you can add to your task for the job in the Azure DevOps
pipelines.

Prerequisites for Azure DevOps integration with IBM® Rational®
Performance Tester
Before you integrate Azure DevOps with IBM® Rational® Performance Tester by using the IBM Rational
Test Workbench extension, you must have completed certain tasks.
• You must have installed IBM® Rational® Performance Tester on a computer running Windows™ or
Linux®.
• You must have created an organization and a project in Azure DevOps for running jobs in Azure
DevOps pipelines. See Creating an organization.
You can now follow the tasks listed in the task flow table to integrate Azure DevOps with Rational®
Performance Tester. See Task flow for integrating Azure DevOps on page 85.

Task flow for integrating Azure DevOps with IBM® Rational® Performance
Tester
The table shows the task flow for integrating Azure DevOps with IBM® Rational® Performance Tester by
using the IBM Rational Test Workbench extension. You must perform these tasks in sequence as listed in
the following table. The table also provides you the links to the information about the tasks.
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Tasks
1

More information

Create any or all of the following types of tests

Rational® Performance Tester

in Rational® Performance Tester to test your

documentation on page

application:
• Compound tests
• Performance tests
• Schedules
2

Access the Visual Studio Marketplace portal

Visual Studio Marketplace

and search for the latest version of the IBM Rational Test Workbench extension.
3

Install the IBM Rational Test Workbench exten Installing the IBM Rational
sion.

Test Workbench extension on
page86

4

Run tests in an Azure DevOps pipeline.

Running tests in an Azure Dev
Ops Pipeline on page87

Related information
Integration with Azure DevOps on page85

Installing the IBM Rational Test Workbench extension
You must install the IBM Rational Test Workbench extension in your Azure DevOps organization before
you use the extension to run tests for your application in an Azure DevOps pipeline. The IBM Rational Test
Workbench extension supports running of tests created in Rational® Performance Tester.
You must have access to the Visual Studio Marketplace portal.
After you install the IBM Rational Test Workbench extension from the Visual Studio Marketplace portal
in your Azure DevOps organization, you can use the extension to run tests for your application in an Azure
DevOps pipeline.
1. Log in to the Visual Studio Marketplace portal, if you are not already logged in.
2. Click the Azure DevOps tab.
3. Search for the IBM Rational Test Workbench extension.
4. Click the IBM Rational Test Workbench extension.
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5. Click Get it free.
The Visual Studio Marketplace portal for the IBM Rational Test Workbench extension is displayed.
6. Select the organization where you want to run your test from the Select an Azure DevOps
Organization list.
7. Click Install.
The installation is completed.
8. Click Proceed to organization.
The Organization page in Azure DevOps is displayed.
9. Click Organization settings > Extensions.
The IBM Rational Test Workbench extension is displayed as an installed extension.
You have installed the IBM Rational Test Workbench extension in your Azure DevOps organization.
You can add tests that you created in Rational® Performance Tester to your task, and then run the tests in
an Azure DevOps pipeline. See Running tests in an Azure DevOps Pipeline on page 87.

Running IBM® Rational® Performance Tester tests in an Azure DevOps
Pipeline
After you create the tests in IBM® Rational® Performance Tester for the application that you are testing,
and after you install the IBM Rational Test Workbench extension in your organization, you can run the
tests in Azure DevOps pipelines.
You must have completed the following tasks:
• Installed the IBM Rational Test Workbench extension in your organization. See Installing the IBM
Rational Test Workbench extension on page 86.
• Installed an agent in your pipeline. See Azure Pipelines agents.
After you add the IBM Rational Test Workbench extension in your Azure DevOps organization, you can
use an existing pipeline or create a new one to add Rational® Performance Tester test tasks. You can
install an agent or use the one that you installed in your default agent pool. You can add the Rational®
Performance Tester tests to your task for the agent job, configure the task, and then run the task in the
Azure DevOps pipeline.
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1. Open your Organization page in Azure DevOps and perform the following steps:
a. Click the project you want to use.
b. Initialize the repository by performing the following steps:
i. Click Repos from the left pane.
ii. Click Initialize from the Initialize with a README or gitignore section.
Note: Select the Add a README check box if it is not selected.
c. Click Pipelines from the left pane.
d. Click Create Pipeline.
e. Click Use the classic editor to create a pipeline without YAML.
f. Verify the project, repository, and branch for manual and scheduled builds, and then click
Continue.
g. Click Empty job.
2. Select Pipeline and complete the following steps:
a. Change the name for the build pipeline if required.
b. Select the Agent pool for your build pipeline.
You can use the agent from the default agent pool or use the one you have installed.
c. Select the Agent Specification for the agent if required.
3. Add a task to the agent job by completing the following steps:
a. Click the Add Task icon

for the agent job.

The Add tasks pane is displayed.
b. Search for the IBM tasks defined in the IBM Rational Test Workbench extension.
The tasks that you can select are displayed.
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Depending on the type of test that you have created in Rational® Performance Tester, you
can select the type of task. You must use the following table to identify the task you must
select:
Type of test

Task to select

• Compound tests

IBM® Rational® Performance Tester

• Performance tests

Task

• Schedules
c. Select the IBM® Rational® Performance Tester Task option, and then click Add to add the
task to the agent job.
The selected task is added to the agent job and it is displayed with a warning that some
settings require attention. You must configure the settings mentioned in step 4 on page
89.
You can also remove the tasks that are not required in your job. Select the tasks in the list
that you want to remove. You can then right-click the tasks, and click Remove selected
task(s) to remove them.
4. Configure the settings by performing the following steps:
a. Select the task version from the list if required.
b. Follow the action for the performance task by referring to the following table:
Note: All mandatory fields are marked with an asterisk (*) in the UI.
Field
Display

Action
Displays the name of the selected task.Enter the name of the task.

name
Product

The complete path to the directory that contains eclipse.exe.

Path
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Field

Action
Enter the complete path of the installation directory of the desktop client.
For example, C:\Program Files\IBM\SDP

IMShared The path to the IMShared folder on your local computer.Enter the com
Path

plete path to the location of the IBMIMShared folder. For example, C:
\Program Files\IBM\IBMIMShared

Work

The complete path to the Eclipse workspace.Enter the complete path of

space

the Eclipse workspace.

Location
Project

The name of the project containing the test.Enter the name of the project

Name

containing the test.

VM Argu Java™ virtual machine arguments to pass in.
ments

Enter the Java™ virtual machine arguments.
Note: You can add multiple virtual machine arguments files separated
by a comma.

Test

The name of a test within the project to use. A test can be a performance

Suite

test, schedule, or compound test.Enter the name of the test that you want

Name

to run.

Var File

The complete path to the XML file that contains the variable name and val
ue pairs.Enter the complete path to the location of the variable file.

Dataset

For a test or schedule, the default value is the dataset specified in the test

Override

editor or schedule editor. Overrides the default dataset value to run if re
quired.Use the Dataset Override option to replace dataset values during a
test or schedule run. If a test or schedule is associated with a dataset, you
can replace the dataset at run time while initiating the run from the com
mand line.
Note:
You must use the Dataset Override option to replace the dataset values
during a test or schedule run. You must ensure that both original and new
datasets are in the same workspace and have the same column names.
You must also include the path to the dataset.
For example,
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Field

Action
/project_name/ds_path/ds_filename.csv:/project_name/ds_path/new_ds_filename.csv.

You can swap multiple datasets that are saved in a different project by
adding multiple paths to the dataset separated by a semicolon (;).
For example,
/project_name1/ds_path/ds_filename.csv:/project_name1/ds_path/new_ds_filename.csv;/project_name2/ds_path/ds_filename.csv:/project_name2/ds_path/new_ds_filename.csv

Resource For a schedule (Rate schedule or VU schedule), use Resource Monitoring
Moni
toring

Labels Override to perform any of the following actions:
• To enable the Resource Monitoring from Service option for a per

Labels

formance schedule if the Resource Monitoring from Service option

Override

is not enabled from the schedule editor in Rational® Performance
Tester.
• To ignore Resource Monitoring sources that were set in the perfor
mance schedule and to change for a label matching mode.
• To replace an existing set of Resource Monitoring labels that were
set in the performance schedule and run the schedule with a new
set of Resource Monitoring labels.
Note: You can add multiple Resource Monitoring labels separated by
a comma.
Important: You must add the Resource Monitoring labels to the Re
source Monitoring sources on the Resource Monitoring page in your IBM®
Rational® Test Automation Server project.

c. Expand Control Options and configure the settings for your task if required.
d. Expand Output Variables and configure the settings for your task if required.
5. Select the following options:
a. Click Save to save the configured settings for the task.
Note: The task is not queued for a run.
You can save the task to a build pipeline and opt to run the build at a later time.
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b. Click Save & queue to save the configurations and queue the run in the pipeline.
The Run pipeline dialog box is displayed.
6. Complete the following steps:
a. Enter a comment for the test in the Save comment field.
b. Select the agent that you configured for the test from the Agent pool list.
c. Select the agent specification from the Agent Specification list for the agent if required.
d. Select the branch from the Branch/tag list.
e. Add the variables and demands for the task run from the Advanced Options pane if
required.
f. Select the Enable system diagnostics check box for a detailed log view.
g. Click Save and run.
The pipeline summary page displays the progress of the job run.
You have run the tests for the application by using the ,IBM Rational Test Workbench extension in the
Azure DevOps pipeline.
You can open the job to view the task logs from the pipeline summary page.
You must click the task to open the Task page to view the test results.
In Rational® Performance Tester, if the IBM® Rational® Test Automation Server URL is configured in
Window > Preferences > Test > Rational® Test Automation Server and Publish result after execution
is set as Always in Window > Preferences > Test > Rational® Test Automation Server > Results, then
the Reports information section on the Task page displays the names of the report along with its
corresponding URLs. The report URLs are the Rational® Test Automation Server URLs where the reports
are stored. You can access the report URLs to view the test execution information at any point of time.

Related information
Running a test or schedule from a command line on page
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Integration of Jaeger with the product
Jaeger is software for tracing transactions between distributed services. You can use Jaeger to monitor
and troubleshoot complex microservices environments.
You can set up the Jaeger UI in your local environment by using one of the following methods:
• One Jaeger agent shared by all Rational® Performance Tester agents
• One Jaeger agent for each Rational® Performance Tester agent
One Jaeger agent shared by all Rational® Performance Tester agents
When you use this method, ensure that the Jaeger agent is accessible by Rational®
Performance Tester and all the Rational® Performance Tester agents. You must set the
JAEGER_AGENT_HOST property as an environment variable by using the command line
before running the schedule.
You must also ensure that the Jaeger agent ports 6831, 6832, and 5778 are accessible from
other computers to communicate with the Rational® Performance Tester agent via the User
Datagram Protocol (UDP). If you want to define any other Jaeger environment variables, set
those environment variables only on Rational® Performance Tester.
One Jaeger agent for each Rational® Performance Tester agent
When you use this method, you must install the Jaeger agent in the same location where
you installed Rational® Performance Tester and on all the Rational® Performance Tester
agents.
You must also ensure that the Jaeger agent ports 6831, 6832, and 5778 are accessible from
other processes on the same computer to communicate with the Rational® Performance
Tester agent via the UDP. If you want to define any other Jaeger environment variables, set
those environment variables on all the computers where the Jaeger agent is installed.
For more information about Jaeger, refer to Jaeger documentation.
Related information
Viewing test logs in Jaeger on page93
Running a test or schedule from a command line on page
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Viewing test logs in Jaeger
You can use the Jaeger UI to view the test logs of the tests or schedules that you run from the commandline interface to analyze traces of transactions between distributed services.
You must have completed the following tasks:
• Downloaded Jaeger components from the Jaeger website.
• Created a test or schedule to run it from the command-line interface. See Creating tests on page
or Creating a VU Schedule on page

.

While running tests or schedules by using the command-line interface, you must include the command
-history jaeger in your test or schedule run. Adding the -history jaeger enables you to view the test log of
the completed test or schedule from the Jaeger UI in a web browser.
1. Run a test or schedule from the command-line interface by adding the -history jaeger option.
For example: cmdline.bat -workspace workspace_full_path -project proj_rel_path -suite
suite_rel_path -stdout -history jaeger
The test or schedule runs and the result of the run is displayed.
2. Open the Jaeger UI in a browser.
For example: http://<host IP>:<port>.
3. Select Rational Test Product from the Service list.
4. Click Find Traces.
In the Jaeger UI, you can view the entire test log of the test or schedule that you ran from the
command-line.
• You can use the Jaeger traces to analyze test results.
• You can compare the traces in the Jaeger UI with test logs in Rational® Performance Tester to
confirm that they are the same.

Related information
Running a test or schedule from a command line on page
Viewing test logs on page
Integration of Jaeger with the product on page92
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EGit integration
EGit is an Eclipse plugin for the Git version control system. You can store your test assets in the Git
repository and use EGit for the daily version control operations.
When you install the product, by default EGit is part of the product. To avoid the clutter, EGit is a separate
Eclipse perspective in the product. For more information about EGit, read its documentation.

In Eclipse perspective, when you initialize a new Git repository for a project, a .gitignore file is created
in the project folder, by default. While committing the contents of a project to Git, the .gitignore file
ignores the report files.
Note:
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• After you pull a project in Git perspective, 'Project is missing required Library' error appears in the
Verify Problems tab. This error occurs due to the .classpath file which is specific to a workspace or
system and needs to be pointed to the newly imported location. To resolve this issue:
1. Under Package Explorer, from the required project, navigate to Java Build Path > Libraries.
2. Delete all the jar files that are missing after the pull. These files are marked with a red cross.
3. Playback the project. The required jar files are added to the project.
• You can also specify additional file types in the .gitignore file so that these file types are
ignored while committing the project contents to Git.

Integration with UrbanCode Deploy
When you use UrbanCode™ Deploy (UCD) for automating application deployments of your application,
you can create tests for your application in IBM® Rational® Performance Tester and run those tests in
UrbanCode™ Deploy by using the IBM® Rational® Performance Tester UCD plugin.

Overview
You can use the IBM® Rational® Performance Tester UCD plugin to integrate UCD with Rational®
Performance Tester. Integrating UCD with Rational® Performance Tester automates the test execution
process. If you have many tests to run at regular intervals automatically, you can use UCD to initiate test
execution.

Prerequisites for UCD Integration
Before you integrate UCD with Rational® Performance Tester by using the IBM® Rational® Performance
Tester UCD plugin, you must have completed certain tasks.
• You must have installed IBM® Rational® Performance Tester on your computer.
Note:
To run tests on Mac OS, you must add an environment variable that points to the installation
directory of the product, for example, export

TEST_WORKBENCH_HOME=/opt/IBM/SDP.

For Windows™

and Linux™, this environment variable is set when you install the product.
• Create any or all of the following types of tests in Rational® Performance Tester to test your
application:
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◦ Compound tests
◦ Performance tests
◦ Schedules
See Rational® Performance Tester documentation on page

.

• Install the latest version of the UCD agent on the UCD server, which runs the tests. See Installing
the UCD Agents.
You can now follow the tasks listed in the task flow table to integrate UCD with Rational® Performance
Tester. See Task flow for integrating UCD on page 97.

Task flow for integrating UCD
The table shows the task flow for integrating UCD with Rational® Performance Tester by using the IBM®
Rational® Performance Tester UCD plugin. You must perform these tasks in sequence as listed in the
following table. The table also provides you the links to the information about the tasks.
Tasks
1

More information

Download the latest version

Test Workbench Resource

of the IBM® Rational® Per

Community

formance Tester UCD plugin
from Test Workbench Resource
Community.
Note: Do not extract the
compressed file contents.
2

Install the latest version of the

Installing the IBM® Rational®

IBM® Rational® Performance

Performance Tester UCD plugin

Tester UCD plugin on the UCD

on page98

server.
3

Run Rational® Performance

Running Rational® Perfor

Tester tests on the UCD server.

mance Tester tests on the UCD
server on page98

Related information
Integration with UrbanCode Deploy on page96
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Installing the IBM® Rational® Performance Tester UCD plugin
You must have downloaded the latest version of the IBM® Rational® Performance Tester UCD plugin
from Test Workbench Resource Community
1. Open the UCD dashboard.
2. Click Settings.
3. Click Automation Plugins from the Automation pane.
4. Click Load Plugin.
5. Click Choose File to locate and Open the compressed IBM® Rational® Performance Tester UCD
plugin file.
Note: Do not extract the IBM® Rational® Performance Tester UCD plugin compressed file
contents.
6. Click Submit.
The IBM® Rational® Performance Tester UCD plugin is displayed in the Automation Plugins tab.
You can add tests that you created in Rational® Performance Tester to your task and then run the tests
on the UCD server. See Running Rational Performance Tester tests on the UCD server on page 98.

Running Rational® Performance Tester tests on the UCD server
After you install the IBM® Rational® Performance Tester UCD plugin on the UCD server, you can create a
process request that contains the test for your application, and then run the test on the UCD server.

You must have installed the latest version of the IBM® Rational® Performance Tester UCD plugin. See
Installing the IBM Rational Performance Tester UCD plugin on page 98.
After you have installed the IBM® Rational® Performance Tester UCD plugin on the UCD server, you
can either use an existing component in your project or create a new component. You can then create
a component process and select the IBM® Rational® Performance Tester test step to edit the step
properties for the test you want to run. After selecting the agent, you can create an application. You can
then create an application process for the application, and then submit the application process for a run.
1. Log in to the UrbanCode Deploy (UCD) server, if you are not already logged in.
2. Click Components from the UCD dashboard, and then click Create Component to create a
component.
Note: You can either use an existing component or create a new component.
3. Create a component process in the component by performing the following steps:
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a. Open the component that you created.
b. Click the Processes tab from the component dashboard, and then click Create Process.
The Create Process dialog box is displayed.
c. Enter the required values to create a component process and click Save.
Note: All mandatory fields are marked with an asterisk (*) in the UI.
i. Enter the process name in the Name field.
ii. Select Operational (No Version Needed) from the Process Type list.
Note: The Default Working Directory field displays the folder path where the agent can
download the artifacts and create temporary files.
The process that you created is listed in the Processes list and the Design tab for the
process is displayed.
Note: The process opens in the process editor. The process editor lists the plugins
and steps. The required Start and Finish steps represent the beginning and the end of the
process and are automatically placed on the design area.
4. Select the process step you want to run by completing the following steps:
a. Search for the IBM® Rational® Performance Tester test process step from the left design
pane.
b. Select the IBM® Rational® Performance Tester test process step and drag the test into the
design area.
The selected test is placed in between the Start and Finish steps.
5. Specify the properties for the selected test by performing the following steps:
a. Click the Edit icon

.

The Edit Properties for Run an IBM® Rational® Performance Tester test dialog box of the
selected test is displayed.
b. Specify the properties for the selected test step by following the action in the table that
follows.
Note: All mandatory fields are marked with an asterisk (*) in the UI.
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Action required for a IBM® Ra

Field

tional® Performance Tester test

Name

Enter the name of the step.

Workspace

The complete path to the Eclipse work
space.

Project

The path, including the file name of the
project relative to the workspace.

Test Suite Name

The path, including the file name of the
test to run relative to the project.

IMShared Location

The complete path to IBMIMShared loca
tion.

Var File

The complete path to the XML file that
contains the variable name and value
pairs.

Config File

The complete path to a file that contains
the parameters for a test or schedule run.

Results File

The name of the results file. The default
result file is the test or schedule name
with a time stamp appended.

Overwrite Results file

Optional. Determines whether a result file
with the same name is overwritten. The
default value is true, which means the re
sult file can be overwritten.

Quiet

Turns off any message output from the
launcher and returns to the command
shell when the run or the attempt is com
plete.

Number of Virtual Users

For a schedule, the default value is the
number of users specified in the sched
ule editor. For a test, the default value is
one user. Overrides the default number
of users, if required. This option creates
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Action required for a IBM® Ra

Field

tional® Performance Tester test
a new copy of the schedule that contains
the specified number of users.

VM Args

Java™ virtual machine arguments to pass
in.

Dataset Override

For a test or schedule, the default value
is the dataset specified in the test editor
or schedule editor. Overrides the default
dataset value to run if required.
Note:
You must use the Dataset Override op
tion to replace the dataset values during
a test or schedule run. You must ensure
that both original and new datasets are in
the same workspace and have the same
column names. You must also include the
path to the dataset.
For example,
/project_name/ds_path/ds_filename.csv:/project_name/ds_path/new_ds_filename.csv.

You can swap multiple datasets that are
saved in a different project by adding mul
tiple paths to the dataset separated by a
semicolon (;).

For example,
/project_name1/ds_path/ds_filename.csv:/project_name1/ds_path/new_ds_filename.csv;/project_name2/ds_path/ds_filename.csv:/project_name2/ds_path/new_ds_filename.csv
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Field
Resource Monitoring Labels Override

Action required for a IBM® Ra
tional® Performance Tester test
For a schedule (Rate schedule or VU
schedule), use Resource Monitoring La
bels Override to perform any of the fol
lowing actions:
• To enable the Resource Monitor
ing from Service option for a per
formance schedule if the Resource
Monitoring from Service option
is not enabled from the schedule
editor in Rational® Performance
Tester.
• To ignore Resource Monitoring
sources that were set in the perfor
mance schedule and to change for
a label matching mode.
• To replace an existing set of Re
source Monitoring labels that were
set in the performance schedule
and run the schedule with a new
set of Resource Monitoring labels.
Note: You can add multiple Resource
Monitoring labels separated by a comma.
Important: You must add the Re
source Monitoring labels to the Resource
Monitoring sources on the Resource
Monitoring page in your IBM® Rational®
Test Automation Server project.

Exported HTTP Test log file

The complete path to a file to store the ex
ported HTTP test log.

Exported Statistical Report Data File

The complete path to the directory to
store exported statistical report data.
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Action required for a IBM® Ra

Field
Custom Report Format Files

tional® Performance Tester test
A comma-separated list of absolute paths
to custom report format files (.view files)
to use when exporting statistical report
data with the -exportstats option.

User Comments

Add text within the double quotation mark
to display it in the User Comments row of
the report.

Field

Optional action for a IBM® Rational®
Performance Tester test

Working Directory

Specify an alternative path to the working
directory for this step.

Post Processing Script

1

Specify if you want to run any scripts after
the completion of the test run.

1

The Step Default is selected by default.
You can click New to add new scripts.
Precondition

Specify any conditions that are to be com
pleted before the test runs. You can edit
the script by clicking the script displayed.
1

Use Impersonation check box

Select this check box to run the test as a
different user.

Auth Token Restriction

1

Set the authentication token actions by
applying token restrictions.

1

The System Default is selected by de
fault. You can add a new token restriction
or edit the one already added.
c. Click OK to save the properties for the test.
6. Click Save in the design area.
7. Click the Resources tab from the UCD dashboard and create a resource by clicking Create TopLevel Group.
1. You need not set this property for a step when you are running an Rational® Performance Tester test.
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The created resource is displayed on the Resource Tree tab page.
8. Select the agent that runs the test by completing the following steps:
Important: You must have already installed the agent on the UCD server that you want to use.
a. Select the resource displayed on the Resource Tree tab page.
b. Click the Horizontal ellipsis icon

for the selected resource.

c. Click Add Agent.
d. Select the agent to add to the resource, and then click Save.
The selected agent is added to the resource in the Resource Tree pane and the status of the
agent can also be viewed.
Important: The agent must be Online for the test to run.
9. Add the component to the agent by performing the following steps:
a. Click the Horizontal ellipsis icon

for the agent.

b. Click Add Component on the list.
c. Select the component to add to the resource, and then click Save.
The selected component is added to the agent for the resource in the Resource Tree pane.
10. Create an application by completing the following steps:
a. Click the Applications tab from the UCD dashboard.
b. Click Create Application.
c. Complete the details in the Create Application dialog box, and then click Save.
The Environments tab page is displayed for the created application.
d. Click Create Environment to create an environment for the application that you created.
e. Complete the details in the Create Environment dialog box, and then click Save.
The environment that you created is displayed.
f. Click the environment to open, and then click Add Base Resources.
g. Select the resource from the list in the Add Resource to Environment dialog box, and then
click Save to add the resource to the environment.
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The resource added to the environment is displayed.
Note: When you add a resource to an environment, the corresponding agent and the
component are displayed for the resource.
h. Click the application from the breadcrumbs.
The Environments tab page is displayed for your application.
i. Add the component to the application by performing the following steps:
i. Click the Components tab.
ii. Click Add Component.
iii. Select the component from the list in the Add a Component dialog box, and then click
Save.
The selected component is displayed on the Components tab page.
j. Create a process for the application by performing the following steps:
i. Click the Processes tab.
ii. Click Create Process.
iii. Complete the details in the Create an Application Process dialog box, and then click
Save.
The Design tab page for the application process that you created is displayed.
k. Select the component process from the left pane and drag it into the design area.
Note: You can click the Edit icon

to add the properties, if required.

l. Click Save in the design area.
11. Select the application process to run the test by completing the following steps:
a. Click Applications from the UCD dashboard.
b. Click the application that you configured for a test run.
c. Click the Request Process icon

.

The Run Process on <environment name> window is displayed.
d. Select the application process that contains the test from the Process list.
e. Click Submit.
The UCD dashboard shows the progress of the application process request.
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You have used the IBM® Rational® Performance Tester UCD plugin to integrate UCD with Rational®
Performance Tester and run the test from your project on the UCD server.
After the UCD process request runs successfully, you can view the status of the completed process
request displayed as follows:
• Success: When the test run is successful
• Failed: When the test run is failed
• You can view the details of the test run as a process from the UCD dashboard. Expand the step.
You can then expand the application process. You can then hover over the process, and then click
the Output Log icon

. The output log is displayed. You can verify the log details.

Note: In Rational® Performance Tester, if the IBM® Rational® Test Automation Server
URL is configured in Window > Preferences > Test > Rational® Test Automation Server and
Publish result after execution is set as Always in Window > Preferences > Test > Rational® Test
Automation Server > Results, then the Reports information section on the Log file displays the
names of the report along with its corresponding URLs. The report URLs are the Rational® Test
Automation Server URLs where the reports are stored. You can access the report URLs to view the
test execution information at any point of time.

Integrating with Apache JMeter
Starting from 9.5, you can use JMeter tests extension with IBM® Rational® Performance Tester to
execute JMeter tests.
In Rational® Performance Tester, you have the option to import JMeter tests, add tests to a schedule or
compound test to run them. Additionally, JMeter test helps to simulate a heavy load on a server, group of
servers, or to investigate overall sample response time under different load types.
JMeter samples are terminal elements in JMeter tests that inform JMeter to send requests to a server
and wait for a response. When you execute a JMeter test, a JMeter performance report is generated
during a run and saved after a run. This report contains the data most significant to the run, shows the
response trend of the lowest 25 samples in the test, and graphs the response trend of each sample for a
specified interval.
With JMeter test, you can load and test the performance of an application that uses the following
protocols:
• HTTP/HTTPS
• SOAP/REST
• FTP
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• LDAP
• MOM
• SMTP/POP3/IMAP
• TCP

Installing the JMeter
To work with JMeter tests, you must download the JMeter executable from https://jmeter.apache.org/
download_jmeter.cgi and unzip it. To run the JMeter test as part of schedule, you must install JMeter on
the remote agent machine and set the JMETER_HOME environment variable to the root installation folder.
To run the JMeter tests, you must either specify the Apache JMeter path in Preferences or set the
environment variable.
Note: When you run the compound test or schedule, an error message is displayed, if you have not
specified the preferences or set the environment variable.
• To access the preference settings for Apache JMeter, click Window > Preferences > Test > Apache
JMeter and point it to the apache-jmeter-5.0 directory.
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• Set the environment variable JMETER_HOME and point it to the apache-jmeter-5.0 directory.

Importing a JMeter test to a Test Workbench project
You can import your JMeter tests to IBM® Rational® Performance Tester to run them as part of VU
schedule.
If you have an existing JMeter test, you can import the test by dragging and dropping a JMeter file (JMX
file) into the project in the test navigator. Alternatively, you can use the following procedure to import the
tests.
1. In the Test Navigator, right-click and click Import.
2. In the Import dialog box, expand General in the source list, select File System and then click Next.
3. Specify the directory where the JMeter test resides.
Click Browse to select a directory from where you can import the JMeter test. The JMeter test
assets in the folder you selected are displayed.
4. Select the JMeter test you want to import.
5. Click Browse to choose the location to import JMeter test.
6. Click Finish. The imported JMeter test is displayed in the JMeter Tests folder.

Adding a JMeter test to an existing VU schedule
You can add a JMeter test to an existing VU schedule to test the performance of both static and dynamic
resources and web applications.
When you add a JMeter test to a VU schedule, a user group with a loop is created and this loop contains
the JMeter test invocation.
1. In the Test Navigator, browse to the schedule and double-click it. The schedule editor opens.
2. In the VU schedule editor, right-click the Schedule, and then click Add > JMeter Test.
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3. In the Select Tests window, expand the project name and JMeter Tests folder and choose the test
that you want to add.
4. Click OK. A new User Group with a loop that contains the JMeter test invocation is created.
You must run the schedule or compound test, to view the statistics on the executed sequences.
• To install the JMeter, see Installing the JMeter on page 107.
• To run the schedule or compound test, see Running a local schedule or test on page
Running compound tests on page

or

.

Converting JMeter tests to VU schedule
You can convert a JMeter test to a VU schedule to load and test the performance of an application under
test.
Rational® Performance Tester analyzes the selected JMeter test to add the number of users and loop
iteration count in the VU schedule. When you convert the JMeter test to a VU schedule, the Thread Group
information from the original JMeter test is extracted to create a new JMeter test and VU schedule. The
extracted JMeter test does not contain any load information because the VU schedule manages all the
information such as the number of users and loop count.
Notes:
• If you have a JMeter test with more than one Thread Group information, each thread group is
extracted to separate the JMeter test. The JMeter test invoked in the user group with a loop is
equal to the number of Thread Group.
• If you have a complex JMeter test, you must extract the functionalities that are included in the
Modules or Include controllers into another JMeter tests. You must then add those JMeter tests to
a VU schedule to run it.
1. In the Test Navigator, browse and select the JMeter test.
2. Right-click and click Convert to VU Schedule. Verify that the schedule name is the name of the
JMeter test.
3. Click Finish. The schedule editor opens.
After you convert the JMeter test to a VU Schedule, you must run it against successive builds of the
application under test and analyze the results that are recorded.
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• To install the JMeter, see Installing the JMeter on page 107.
• To run the schedule or compound test, see Running a local schedule or test on page
Running compound tests on page

or

.

JMeter Performance report
The JMeter performance report summarizes the validity of the run, shows the average sample response
time for the requests in the test, and graphs the sample response time of each sample for a specified
interval.

Overall page
The Overall page provides a progress indicator that shows the status of the run and a bar chart that
shows percentage of passed JMeter samples.

Summary page
The Summary page provides important information about the run. This page shows the following Run
Summary information:
• The name of the test.
• The number of active users and the number of users who completed testing. This number is
updated during the run.
• The elapsed time is the run duration, which is displayed in hours, minutes, and seconds.
• The status of the run. For example, the status can be Initializing Computers, Adding Users,
Running, Transferring data to test log, Stopped, or Complete.

JMeter Samples page
JMeter samples are terminal elements in JMeter tests that informs JMeter to send requests to a server
and wait for a response. The JMeter Samples page shows the average sample response time for all the
requests in the test. The bar chart shows the average sample response time for all the requests. Each
bar represents a sampler of the JMeter test. The corresponding table provides the following additional
information:
• The minimum, average, and maximum duration for each sample in the run.
• The standard deviation of the duration.
• The completed sample rate and total number of completed samples per request.

JMeter Transaction page
The JMeter Transaction page shows the average transaction response time for all the requests in the
test. The bar chart shows the average transaction response time for all the requests. Each bar represents
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a page that you visited during recording. The corresponding table provides the following additional
information:
• The minimum, average, and maximum duration for each transaction in the run.
• The standard deviation of the duration.
• The completed transaction rate and total number of completed transaction per request.

Samples versus Time Summary page
The Samples versus Time Summary page shows the sample response trend as graphed for a specific
interval. The Sample Response versus Time graph shows the sample response time for all the requests
during the run. Each point on the graph is an average of what has occurred during that sample interval.
The table after the graph lists the total average duration for all requests in the run and the standard
deviation. To set the sample interval value, open the schedule, choose the Statistics tab from the dropdown menu, and then view or modify Statistics sample interval.

Samples versus Time Detail page
The Samples versus Time Detail page shows sample response trend for each of the request in the test.
The line graph shows the average sample response time of each requests for a specific interval. The
table after the graph provides the minimum, average, and maximum duration for the run and the standard
deviation in the average sample response time.

Sample Throughput page
The Sample Throughput page summarizes the frequency of requests that are transferred per sample
interval. The line graph on the left side shows the sample rate and passed sample rate per interval for
all samples. The summary table after the graph lists the passed rate of total samples and counts for
each passed samples. The line graph on the right side shows active users and the users who completed
testing, per interval, over the course of a run. You can set the Statistics sample interval value in the
schedule, as a schedule property. As the run nears completion, the number of active users decreases
and the number of completed users increases. The summary table after the graph lists the active and
completed users for the entire run.
To set the sample interval value, open the schedule, choose the Statistics tab from the drop-down menu,
and then view or modify Statistics sample interval.

Server Throughput page
The Server Throughput page lists the rate and number of bytes that are transferred per interval and for the
entire run. The page also lists the status of the virtual users for each interval and for the entire run. The
line graph on the left side shows the rate of bytes sent and received per interval for all intervals in the run.
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The summary table after the graph lists the total number of bytes sent and received and bytes sent and
received throughput rate for the entire run.
The line graph on the right side shows active users and users who are completed testing, per interval, over
the course of a run. You set the Statistics sample interval value in the schedule, as a schedule property.
As the run nears completion, the number of active users decreases and the number of completed users
increases. The summary table after the graph lists the active and completed users for the entire run.

Server Health Summary page
The Server Health Summary page gives an overall indication of how well the server is responding to the
load. The bar chart shows the total number of samples and total number of passed samples for the run.
The table under the bar chart lists the same information.

Server Health Detail page
The Server Health Detail page provides specific details for 25 samples with the lowest success rates. The
summary table lists the number of samples completed and passed in the run, and the passed sample
percent and completion rate.
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This document provides information about copyright, trademarks, terms and conditions for the product
documentation.
© Copyright IBM Corporation 2001, 2016 / © Copyright HCL Technologies Limited 2016, 2021
This information was developed for products and services offered in the US.
IBM® may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM® representative for information on the products and services currently available
in your area. Any reference to an IBM® product, program, or service is not intended to state or imply that
only that IBM® product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM® intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM® product, program, or service.
IBM® may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US
For license inquiries regarding double-byte character set (DBCS) information, contact the IBM®
Intellectual Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.
This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
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IBM® may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM® websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM® product and use of those websites is at your own risk.
IBM® may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US
Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.
The licensed program described in this document and all licensed material available for it are provided by
IBM® under terms of the IBM® Customer Agreement, IBM® International Program License Agreement or
any equivalent agreement between us.
The performance data discussed herein is presented as derived under specific operating conditions.
Actual results may vary.
Information concerning non-IBM® products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM® has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM®
products. Questions on the capabilities of non-IBM® products should be addressed to the suppliers of
those products.
Statements regarding IBM®'s future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.
This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to actual people or business enterprises is
entirely coincidental.
COPYRIGHT LICENSE:
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This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM®, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform
for which the sample programs are written. These examples have not been thoroughly tested under
all conditions. IBM®, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM® shall not be
liable for any damages arising out of your use of the sample programs.
Each copy or any portion of these sample programs or any derivative work must include a copyright
notice as follows:
© (your company name) (year).
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2000, 2017.

Trademarks
IBM®, the IBM® logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM® or other companies. A current list of IBM® trademarks is available on the web at
"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability
These terms and conditions are in addition to any terms of use for the IBM® website.

Personal use
You may reproduce these publications for your personal, noncommercial use provided that all proprietary
notices are preserved. You may not distribute, display or make derivative work of these publications, or
any portion thereof, without the express consent of IBM®.

Commercial use
You may reproduce, distribute and display these publications solely within your enterprise provided that all
proprietary notices are preserved. You may not make derivative works of these publications, or reproduce,
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distribute or display these publications or any portion thereof outside your enterprise, without the express
consent of IBM®.

Rights
Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.
IBM® reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use
of the publications is detrimental to its interest or, as determined by IBM®, the above instructions are not
being properly followed.
You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.
IBM® MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS
ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT,
AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement
IBM Software products, including software as a service solutions, (Software Offerings) may use cookies
or other technologies to collect product usage information, to help improve the end user experience,
to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you
to collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering use of cookies is set forth below.
This Software Offering does not use cookies or other technologies to collect personally identifiable
information.
If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.
For more information about the use of various technologies, including cookies, for these purposes,
see IBM's Privacy Policy at http://www.ibm.com/privacy and IBM's Online Privacy Statement at http://
www.ibm.com/privacy/details in the section entitled Cookies, Web Beacons and Other Technologies,
and the IBM Software Products and Software-as-a-Service Privacy Statement at http://www.ibm.com/
software/info/product-privacy.
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